ENESAS APPLICATION NOTE

Renesas Synergy™ Software Package (SSP) v1.1.0 RI1AN0024EU0140
ev.l.

Developer Examples Sep 1, 2016

Introduction

The purpose of this Application Note is to get you started using the Developer Example applications included with SSP.
A Developer Example is a simple application demonstrating the functionality of each SSP Framework or HAL module.
You can call each application via a command line interface on a serial terminal.

Target Device and Software Requirements

e DK-S7G2

e Renesas Synergy €? studio v5.0.0.043

NOTE: This release was tested with Renesas Synergy Software Package v1.1.0. The Developer Examples and the
associated project template is automatically installed with any SSP v1.1 installer.
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1. Prerequisites

This guide assumes that you have installed the Synergy Software Package (SSP) and e? studio ISDE on your computer
and have the DK-S7G2 board successfully configured and set up with the J-Link debugger. You can verify that board
and e? studio ISDE are working correctly by running the ‘Blinky’ demonstration example available for all Renesas
Synergy boards. In addition, you need a common PC hosted editor.

It is also helpful if you have some familiarity with the overall layout of the e? studio ISDE windows and with generating
Synergy projects in e? studio, since the steps below are less ‘guided’ than the steps in the ‘Blinky’ project and they don't
illustrate each window or command location used in each step.

All examples use a terminal emulator program such as Tera Term.

2. Overview

This document is intended for developers who use the Synergy DK-S7G2 Development Kit and want to get a quick start
on how to use a module and its interface.

This document provides detailed information about how to exercise the module’s APIs from the command line using a
terminal emulator like Tera Term.

This document also explains about how to select the Root menu in command line interface and how to select the
specific modules menu from Root menu. Screen shots of the terminal window show the supported commands and how
to use the commands.

3. Build and Run a Developer Example application

You can build and run all Developer Example applications described in this document by following these common
steps:

STEP 1: Launch e? studio. Navigate to File>New > Synergy Project. The Import dialog box opens.

Import = x
Select \“
Create new projects from an archive file or directory. E E
Select an import source:
type filter text
4 (= General -
& Archive File
[ CMSIS Pack

Ta# Convert CCRX to GNURX Project
TaF DS-5 KPIT GNUARM-RZ/NONE Praject
(> Existing Projects into Workspace
() File System
i HEW Project
[} Preferences
=% Rename & Import Existing C/C++ Project into Workspace
@ Renesas Common Project File
= C/C++
= Code Generator
= CVS
. Git

@ < Bac Next > Finish Cancel

STEP 2: Enter a name for your project, select a license file, and click Next. Select version 1.1.0 of the SSP and the
S7G2 DK board. Click Next.
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STEP 3: Select the project S7TG2-DK Developer Examples. Click Finish.

ﬁ e2 studio - Project Configuration (Synergy Project) - |EI|§|
e2 studio - Project Configuration (Synergy Project) —

Select the type of project you wish to create. |

rProject Template Selection

| v

c ‘ BSP
(3 Base Board Support Package for the chosen Synergy family, Mo RTOS induded.

c ‘| S7G2-DK BSP
(} Board Support Package for the 57G2-DK. Mo RTOS included.

s ‘| $7G2-DK Blinky
(3 Blinky for the SPG2-DK.

s ‘| $7G2-DK Blinky with ThreadX
Threaded version of Blinky for the 57G2-DK.

@ (3' ‘| 87G2-DK Developer Examples

Developer example code exercised over a command line interface. vI

~Code Generation Settings
v Use Synergy Code Formatter

? Bk | weds [ Ensh | cancel

STEP 4: Build the project.
STEP 5: Connect the DK-S7G2 board to the host PC. Two connections are needed:
a) The JTAG debug connection to program and debug the board

b) The USB-CDC connection for console access

USB Serial
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STEP 6: Power on the board. In ISDE, click Run>Debug configurations. A new debug configuration with the project
name will be created. Click Debug.

[e?] Debug Configurations X
Create, ge, and run ig i v&‘\
K ICE

Name: Developer Examples Debug

[Z Main %% Debugger| B Startup| [] Common | & Source
C/C++ Application
C/C++ Remote Application
Debug-only Developer Examples | Browse. |
GDB Hardware Debugging
GDB Simulator Debugging (SH, RLT
GHS Local C/C++ Launch Debug/Developer_Examples.elf

Project:

C/C++ Application:

ng Variables... ‘ |Search iject..‘l | Browse... ‘

[c7] Developer_Examples Debu
T — Build (i required) before launching

Build configuration: | Use Active -

Enable auto build Disable auto build

@) Use workspace settings Configure Workspace Seftings...

Pl . r

Filter matched 9 of 12 items

@ (S

Close

STEP 7: Click Yes to switch to the Debug Perspective if you are asked.

STEP 8: Click the Resume button ' twice so that the application starts its scheduler.

STEP 9: If this is the first time launch, wait for the host PC to recognize the USB device as composite device and
install the required driver. Once the driver is installed, launch Tera Term.

STEP 10: Choose the serial connection and choose the corresponding serial port (COM3: JLink CDC UART Port
[COM3)).

File Edit Setup Contrel Window Help

Tera Term: Mew connection

O TCPAP fC=1 ;serial port
History
Telnet

S5SH SSH2
Other

22

UNSPEC

® Serial Port: | COM3: JLink CDC UART Port [COM3] -~

Cancel Help
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STEP 11: Press the Enter key to get the console prompt.

200baud - Tera Term VT

File Edit Setup Control Window Help

i 38 e 3 350 s i 3B e i 3R s o i e i i e ke i e R e sk s e ke R R sk e ke R e sk R s R e sk sk R e R ek s sk ek ke ke ke

Synergy Developer Example applications *

Version 1.1.0 *

Hit ? to show command list *

i ¢ e i e she i e e i s e i S e i e i e e 5B e e e e e i e she i e sl i s i o e sl e sl i e e i e e e sl e ol e e i ke e i

synergy )I

Developer Examples

STEP 12: Type ? and press Enter to get the Help menu showing a list of supported Developer Example applications.

)baud - Tera

synergy Help Menu
help : Prints the help information for Developer Example
r_flash hp : Exercise Flash HAL APIs
r sci i2c : Exercise SCI_T2C HAL APIs
r_gpt : Exercise Timer GPT HAL APIs
r_adc : Exercise ADC HAL APIs
r_qspil : Exercise QSPI Flash HAL APIs
r_crc : Exercise CRC HAL APIs
r_dac : Exercise DAC HAL APIs
r_agt : Exercise Timer AGT HAL
r_wdt : Exercise WDT HAL APIs
r_rtc : Exercise RTC HAL APIs
r_icu : Exercise EXTIRQ API's
r_fmi : Exercise the FMI hal API's
r_lpm : Exercise LPM HAL API's
r_ioport : Exercise IOPORT HAL API's
sf audio playback : Exercise Audio framework APIs
st i2c : Runs a I2c Framework Application
st _adc_periodic : Exercise ADC framework APIs

st _thread monitor : Runs a Thread Monitor Framework Application

st el fx : Exercise the FileX framework API's

st el ux comms : Exercise COMMS framework APIs

st _touch_panel i2c : Run I2c Touch framework Application

st _external irq : Exercise the External IRQ framework API's
st el nx comms : Runs a COMMS framework on NETX Application

synergy>]]
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To enter the submenu for any of the Developer Examples, type the name of the application and press Enter. For
example, to use the ADC Framework application, type s¥_adc_periodic. To see a list of the supported APIs,
press ? and Enter.

NOTE: Commands typed in the Tera Term window are not case sensitive
4. Developer Example: ADC Periodic Framework

4.1 Introduction
The ADC Periodic Framework operates as follows:

The GPT timer is configured to trigger an ADC group scan at periodic intervals. When the scan is complete, a DTC
operation is triggered which copies the scan result to a user buffer. When completing such iterations, you are notified
about the data transfer.

In this Developer Example, the ADC is configured to scan channel (AN00O), which is connected to a potentiometer on
the DK-S7G2. When the scan is complete, the DTC triggers a data transfer to the user buffer and the listening thread is
notified. When receiving the notification, the thread uses 12C HAL drivers to interface to an on-board 1/0 expander
which toggles the LEDs. This operation is repeated with the period configured for the GPT timer.

4.2 Run the ADC Periodic Framework application

Follow the steps described in Build and Run a Developer Example application to obtain the help menu with the list of
applications in the terminal window.

To run the ADC Periodic Framework application, follow these steps:

STEP 1: Type sT_adc_periodic in the terminal and press Enter to access the ADC Periodic Framework submenu.
For help, type ? and press Enter.

“ COM3:115200baud - Tera Term VT — O e
File Edit Setup Contrel Window Help

synergy>st_adc _periodic
st _adc _periodic>?
st_adc_periodic Help Menu
: Back to root menu
A i Up one menu level
open : Initialize ADC periodic framework
scanStart : Start the scan
top : Stop the scan
close : Close the ADC periodic framework
versionGet : Gets the version of API

sf_adc_periodic>]]

STEP 2: Execute the open command. It opens the SCI 12C HAL driver and configures the 1/0 expander. It also
configures the ADC Periodic Framework, but as part of the thread entry function, the ADC framework is already
opened. Thus it might result in an SSP_ERROR_IN_USE. You can safely ignore that error.
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“ COM3:115200baud - Tera Term VT — O e
File Edit Setup Control Window Help

sf_adc_periodic>open

Opening ADC periodic framework
SSP_SUCCESS

Open I2C HAL driver
SSP_SUCCESS

Initialize PCAL

SSP_SUCCESS
sf_adc_periodic)l

STEP 3: Start the scan using the command scanStart. Turn the knob of the potentiometer and observe that the
LEDs toggle based on the direction of the motion of the knob.

. COM3:115200baud - Tera Term VT — O s
File Edit Setup Control Window Help

sf_;dc_pe;iodic>l
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“ COM3:115200baud - Tera Term VT — [m} e
File Edit Setup Control Window Help

sf_adc_periodic>scanStop
SSP_SUCCESS
sf_adc_periodic>]]

STEP 5: Close the ADC framework instance by typing the close command. Closing the ADC Framework instance
also closes the 12C HAL drivers that were opened as part of the open command.

“ COM3:115200baud - Tera Term VT — O e
File Edit Setup Control Window Help

sf_adc_periodic>close
SSP_SUCCESS
sf_adc_periodic>]]

5. Developer Example: ADC HAL driver

51 Introduction

This Developer Example uses the ADC HAL APIs in single scan mode. On the DK-S7G2 board, channel 0 of the ADC
is connected to a potentiometer. You can observe the changes in ADC value when the potentiometer knob is varied and
a scan is performed.

5.2 Run the ADC HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To perform a scan and read the ADC value, follow these steps:

STEP 1: Type r_adc in the terminal and press enter to access the ADC HAL submenu. For help, type ? and press
Enter.
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COM3:115200baud - Tera Term VT — O *

File Edit Setup Contrel Window Help

synergy>r adc
r_adc>?
r_adc Help Menu
~ : Back to root menu
A 1 Up one menu level
open : Initilize adc unit
scanCfg : Configure the scan including channel and groups
scanStart : Start the scan or enable the hardware trigger
scanStop : Stop the ADC scan or disable the hardware trigger
scanStatusGet : Check scan status.
read : Read ADC conversion result(s).
infoGet : Read ADC information for configured channel
sampleStateCountSet : Set sample state count
Synopsis:- sampleStateCountSet reg id# num states#
Example:- sampleStateCountSet reg_id7 num_states2
versionGet : Gets the version of API
close : Close the specified ADC unit

r_adcf

STEP 2: Invoke each menu item with the corresponding arguments to use the APIs. First configure the scan by
executing the following commands in sequence:

1. open
2. scanCfg

To read the ADC value, first perform a scan using the scanStart command and then read the value using the read
command:

1. scanStart

2. read
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L. COM3:115200baud - Tera Term VT — O >
File Edit Setup Control Window Help

r_adc>open

P_aaﬁ)sanCFg

6. Developer Example: Audio Playback Framework

6.1 Introduction

This Developer Example demonstrates the play API of the Audio Playback Framework. You can enable and configure
the DAC to playback an audio file in .0ogg format stored on an SD card and control the playback using the terminal. In
addition to the Audio Playback Framework, the example also uses the FileX Adaptation Framework (FX_10) and the
SD/MMC card drivers.

6.2 Run the Audio Playback Framework application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the Audio Playback Framework application, follow these steps:

STEP 1: Type sf_audio_playback and press Enter to get the audio menu.
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L COM3:115200baud - Tera Term VT
File Edit Setup Control Window Help

synergy>st_audio_playback
st _audio playback>?

st_audio_playback Help Menu

~ : Back to root menu
~ Up one menu level

1s : Display the list of files
play : Play the audio file:
pause : Pause audio play back

play <filename>

resume : Resume audio play back

stop : Stop audio play back

sf_audio_playback>|]

STEP 2: Type Is in the terminal and press enter to access the directory list of the SD card. For help, type ? and press

Enter.

L COM3115200baud - Tera Term VT
File Edit Setup Contrel Window Help

st audio playback>1s

BOOT . IMX6QS

System Volume Information
audio.ogg

Renesas.ogg

sample.txt
sf_audio_playback>]}

STEP 3: Type play Renesas.ogg in the terminal and press Enter to perform audio playback of Renesas.ogg stored
on the SD card. For help, type ? and press Enter. You can use stop, pause and resume in the same way.
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L COM3:115200baud - Tera Term VT — O >
File Edit Setup Control Window Help

st_audio playback>play Renesas.ogg
ARTIST=test

Bitstream is 1 channel, 44100Hz
Encoded by: Xiph.Org libVorbis I 20101101 (Schaufenugget)

st_audio playback>pause
Playback paused

st _audio playback>resume
Playback resumed
st_audio_playback>stop
Playback stopped
sf_audio_playback)l

6.3 Limitations
The Audio Playback Developer Example has the following limitations:

e  The only supported audio format is .0gg.
e Audio files must be in mono format with a sample rate of 44.1 kHz.

e The stop, pause, and resume commands of this Developer Example work by manipulating the audio
thread and do not use the Audio Playback APIs directly.

7. Developer Example: DAC HAL driver

7.1 Introduction

The Developer Example uses the APIs of the DAC HAL module from the terminal command line. The Developer
Example generates a triangle and a sine wave on the DAC output.

7.2 Run the DAC HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the DAC HAL driver application, follow these steps:
STEP 1: type r_dac and press Enter to get the DAC HAL menu.
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L COM3:115200baud - Tera Term VT — O X
File Edit Setup Control Window Help

synergy>r_dac
r _dac>?
r_dac Help Menu
~ 1 Back to root menu
At Up one menu level
open : Initial configuration
close : Stop the D/A conversion,stop output,and close the DAC channel.
write : Write data to the D/A converter
Synopsis:- write WAVE#(@ - triangle wave, 1- sine wave)
Example:- write WAVEL
start : Start the D/A conversion output if it has not been started call
write before start to choose the wave form
stop : Stop the D/A conversion output if it has not been started.
versionGet : Gets the version of API

r_dac>j]

STEP 2: Type open in the terminal and press Enter to initialize the DAC HAL module. For help, type ? and press
Enter.

2. COM3:115200baud - Tera Term VT — O =
File Edit Setup Contrel Window Help

r_dac>open

SSP_ERR_HW_LOCKED

Closing DA® opened by audio thread
SSP_SUCCESS

Open DA@ for DAC HAL

SSP_SUCCESS

Open Timer For DAC

STEP 3: Type start in terminal and press Enter to enable the DAC. For help, type ? and press Enter.
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L. COM3:115200baud - Tera Term VT
File Edit Setup Control Window Help

r_dac>start
Start DAC

SSP_SUCCESS
Start Timer
SSP_SUCCESS
r_dac>stop
Stop DAC

SSP_SUCCESS
Stop Timer

STEP 4: Type write WAVE# (#=0 for triangle waveform #=1 for sine wave form) in the terminal to select the
waveform and then type start and press Enter to demonstrate the selected waveform’s Digital-to-Analog output. For

help, type ? and press Enter.

L. COM3:115200baud - Tera Term VT
File Edit Setup Control Window Help

r_dac>write WAVE 1

r_dac>start
Start DAC

SSP_SUCCESS
Start Timer
SSP_SUCCESS
_dac>stop
Stop DAC

SSP_SUCCESS
Stop Timer
SSP_SUCCESS

r_dac>]]

7.3 Limitations

The close command in this Developer Example does not execute the close APl of DAC HAL module to prevent a
conflict with the Developer Example for the Audio Playback Framework, which also requires the DAC HAL module.
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8. Developer Example: AGT HAL driver

8.1 Introduction

The AGT Hal driver Developer Example uses the periodic interrupt of the AGT. The interrupt toggles the LED1 on the
DK-S7G2 board. The Developer Example also allows you to dynamically set the time period of the AGT timer from the
command line interface while the timer is running.

8.2 Run the AGT HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the AGT HAL driver application, follow these steps:
STEP 1: Type r_agt in the terminal and press Enter to access the AGT HAL submenu. For help, type ? and press Enter.

COM3:115200baud - Tera Term VT - O *
Edit Window Help

File Setup Control
synergy>r_agt
r agt>?
r_agt Help Menu
~ 1 Back to root menu
A 1 Up one menu level
open : Open the AGT channel as a timer

close : Stops counter, disables
and clears internal driver
Retrieve and store
Sets period value
Synopsis:- periodSetit(Value

counterGet
periodSet

interrupts and output pins
data
counter value

in msecs)

Example:- periodSet 1000
dutyCycleSet : Setting duty cycle is not supported by this driver
Reset : Resets the counter value to the period that was originally s
Start : Starts timer
Info : Get timer information
Stop : Stops the AGT channel
Version : Driver version

r_agt}l

STEP 2: Using the open and then start commands starts the AGT to run for the period that is configured in the
Synergy Configuration tool and passed into open.

- COM3:115200baud - Tera Term VT — O %
File Edit Setup Contrel Window Help

r_agt>open

‘_aét)star‘t
SSP_SUCCESS

SSP_SUCCESS
r_agt>
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When the timer overflow interrupt occurs, LED1 on the DK-S7G2 board lights up. You can reconfigure the timer using
periodSet

9. Developer Example: GPT HAL driver

9.1 Introduction
The GPT HAL driver Developer Example uses the GPT interrupt to toggle LED1 on the DK-S7G2 board.

9.2 Run the GPT HAL Driver applications

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the GPT HAL driver application, follow these steps:

STEP 1: Type r_gpt in the terminal and press Enter to access the GPT HAL submenu. For help, type ? and press
Enter.

COM3:115200baud - Tera Term VT - O *

File Edit Setup Control Window Help

synergy>r_gpt
r_gpt>?
r_gpt Help Menu
~ 1 Back to root menu
A 1 Up one menu level
open : Opens the GPT Timer driver
stop : Stop the timer
start : Start the timer
reset : Reset the timer to the initial value
counterGet : Get current timer value
periodSet : Set the timer period
Synopsis:- periodSet#(Value in msecs)
Example:- periodSet 2000
versionGet : Gets the version of API
infoGet : Get information about the timer
close : Close the driver

P_gpt)l

STEP 2: Usetheopen and then startcommandsto run the GPT for the period configured in periodSet. When the
timer overflow interrupt occurs, LED1 on the DK-S7G2 board lights up. You can reconfigure the timer using
periodSet.

L. COM3:115200baud - Tera Term VT - O >
File Edit Setup Control Window Help

r_gpt>open
SSP_SUCCESS
r_gpt>start
SSP_SUCCESS
r_gpt>stop

SSP_SUCCESS
r_gpt>close
SSP_SUCCESS
r_gpt>fl
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10. Developer Example: CRC HAL driver

10.1 Introduction

The cyclic redundancy check (CRC) detects errors in a dataset. The Developer Example uses the Snooping API
function of the CRC HAL Module. The snoop function monitors read and writes to specific addresses. This function is
useful in applications that require CRC code to be generated automatically in certain events, such as monitoring writes
to the serial transmit buffer and reads from the serial receive buffer. The Developer Example uses the SCI 12C channels
as an example.

10.2 Run the CRC HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the CRC HAL driver application, follow these steps:

STEP 1: Type r_crc in the terminal and press Enter to access the CRC HAL submenu. For help, type ? and press
Enter.

COM3:115200baud - Tera Term VT - O *

File Edit Setup Control Window Help

SYNergy>r_crc
r_crc»?
- Help Menu

~ : Back to root menu

A : Up one menu level

open : Open the CRC driver module

close : Close the CRC module driver

crcResultGet : Return the current calculated value.

snoopEnable : Enable snooping

Synopsis:- snoopEnable seed#

Example:- snoopEnable seed32

snoopDisable : Disable snooping

snoopCfg : Configure snoop
Synopsis:- snoopCfg channel#(@ -7) direction#{ @ or 1)
Example:- snoopCfg channel?7 directionl

calculate : Perform a CRC calculation

Synopsis:- calculate lengthit seedit data#f
Example:- calculate length®2? seed25 data3f d4
versionGet : Get the driver version based on compile time macros

l

STEP 2: Invoke each menu item with the corresponding arguments to exercise the APIs. The example shows the CRC
calculate command with length, seed and data option. It calculates CRC for the given length of data with a specific
seed.
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L COMZ115200baud - Tera Term VT — O *
File Edit Setup Control Window Help

r_crc>open

SSP_SUCCESS

r_crcr>calculate length®2 seed25 data3f d4
SSP_SUCCESS

crc result 242

—crc>calculate length®2 seed37 data3f d4

SSP_SUCCESS
crc result 247
r_crc )I

The following example shows the CRC snoop operation using snoopCfg and snoopEnable command along with
running an 12Cframework application.

1. Enter r_crc followed by open and snoopC¥g with channel and direction details
L COM3:115200baud - Tera Term VT — | >

File Edit Setup Control Window Help

r_crcropen
;SP_SUCCESS
cre>snoopCtg channel 7 direction 1

2. To validate snoop operation of r_crc any one SCI channel must be configured with respect to CRC snoop. In
Developer Example sf_i2c uses SCI channel 7 so run the 12C Framework application from the sf_i2c menu and
switch back to the r_crc menu and execute the following commands in sequence.

1. open

2. snoopCfg

3. snoopEnable
4

crcResultGet
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2. COM115200baud - Tera Term VT — ] =
File Edit Setup Control Window Help

_crcxopen
SSP_SUCCESS
noopCfg channel 7 direction 1
CESS
noopEnable seed 25
CESS
esultGet

= 25
r_crc>crcResultGet
SSP_SUCCESS
CRC result = 25
r_crc> I

11. Developer Example: Flash HAL driver

11.1 Introduction

This example uses the high performance flash (flash HP) on the S7G2. The on-chip Flash consists of a code flash and a
data Flash. The address range for code flash is 0x0000000 — 0x00400000 and the address range for data flash is
0x40100000 — 0x40110000. Code flash has blocks from 0-133, which is a total of 134 blocks. Data Flash has blocks
from 0-1023 with a total of 1024 blocks. The code flash is defined as TYPEOQ and data flash as TYPEL in the Developer
Example. The Flash Developer Example restricts the write and erase operations to certain code block regions since they
may corrupt the Developer Example code itself. The Developer Example application will issue a warning message if
you try to access a prohibited block and will not write to or erase that particular block.

11.2 Run the Flash HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the Flash HAL driver application, follow these steps:

STEP 1: Type r_flash_hp and press Enter to access the flash HAL submenu. For help, type ? and press Enter.
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L COM3:115200kbaud - Tera Term VT
File Edit Setup Control Window Help

r_flash _hp>?
r_flash_hp Help Menu

~ : Back to root menu

A 1 Up one menu level

open : Open the driver

read : Read flash block(only first 256Bytes for CF)
Synopsis:-read TYPE#(@-code 1-data) BLOCK#(@-1023)
Example:-read TYPE1 BLOCK4

write : Writes pattern byte into block
Synopsis:-write TYPE#(@ or 1)BLOCK#(@-1823) PATTERN#
Example: -write TYPE1 BLOCK2 PATTERNS

erase : Erase a flash block
Synopsis:-erase TYPE#(@-code 1-data) BLOCKi#(©-1023)
Example: -erase TYPE1 BLOCK5

blankCheck : Check whether flash block is blank
Synopsis:-blankCheck TYPE#(@ or 1) BLOCK#(9-1023)
Example: -blankCheck TYPE® BLOCKS5

close : Close the Flash driver

statusGet : Gets the status of the flash peripheral

reset : Reset the flash device

accessWindowSet : Set access window
Synopsis:-accessWindowSet SBLOCK#(©-133) EBLOCK#(©-133)
Example: -accessWindowSet SBLOCK184 EBLOCK14

accessWindowClear : Clear the access window

startupAreaSelect : Select the startup area
Synopsis:-startupAreaSelect BLOCK(@-1)(Only temporary)
Example: -startupAreaSelect BLOCK®

updateClockFreq : Update the frequency of flash clock

versionGet : Get the API version

P_flash_hp>l

STEP 2: Use the read command to read from blockO of the code block.
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L COM3:115200baud - Tera Term VT

File Edit Setup Contrel Window Help
r_tlash_hp>open

SSP_SUCCESS

r_tlash_hp>read TYPE® BLOCK®
POERERER = E8 28 06 20 E5 6D
00eLev1e = F5 6D 01 ©© F5 6D
PPeRB2e 20 P2 PO PO QL Qv
20000030 F5 6D 91 90 00 00
DReReB4R 19 85 91 e 5D a5
PYeReV50 89 EY ©© @0 C9 E7
jalalzlelaleoe] A9 64 91 9O Al 36

PRV 7O 1C 91 ee 89 1C
DA ©© @8 35 DB
20 V0 PO Y

00 00 00 00 v
00 00 00 00 BB
00 00 00 00 v
00 00 00 00 BB
90 00 00 00 0.
= 00 00 00 00 BB
P;flash;hp>l

STEP 3: Use the read command to read from blockO of the data block.

L COM3:115200baud - Tera Term VT —

File Edit Setup Contrel Window Help

r_flash_hp>open

SSP_SUCCESS

r_flash_hp>read TYPE1l BLOCK®
= 90 20 40 88 @0 ©4 00
= FB DF 9F &7 F7 FE FF
= FE D9 F3 7D F8 F3 FF
= 0B 89 46 480 20 86 91

P_flash_hp)l

@2 14 oo
F4 FF BF
FF 7F 9F
e1 04 o1

STEP 4: Use the write command to write to block255 of the data block with any pattern value. The Developer
Example disables the write into code flash area to protect from corrupting the code that runs the Developer Example

program.
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L. COM3:115200baud - Tera Term VT — O =
File Edit Setup Contrel Window Help

r_ftlash_hp>open
SSP_SUCCESS
r_flash _hp>write TYPE 1 BLOCK 255 PATTERN ©©
SSP_SUCCESS
r_flash _hp>read TYPE 1 BLOCK 255
PO 00 00 00 00 VO VO 0O OO 0O 00

00 20 00 00 00 Q0 00 00 B0 00 00

00 20 00 00 OV Q0 00 00 B0 00 00
00 20 00 00 00 20 00 00 B0 00 00
P_flash_hp)l

STEP 5: Use the erase command to erase to block255.

L COM3:115200kaud - Tera Term VT — O =
File Edit Setup Control Window Help

r_flash_hp»open

SSP_SUCCESS

r_flash_hp»>read TYPE 1 BLOCK 254
22 90 90 8© 85 @@ ©4 22
BF FF 7F CF FF 4F F7 6F
F1 FF FF EF FF F&6 JE DF
= 93 10 E@ 1© ©8 80 @1 08
r_flash_hp»erase TYPE 1 BLOCK 254
SSP_SUCCESS

P_flash_hp)l

11.3 Limitations
The Flash HAL Developer Example has the following limitations:

e The size of a block of data flash is 64 bytes. The size of a block of code flash is either 8 KB (BLOCKO -
BLOCKY7) or 32 KB (BLOCKS8 - BLOCK133). Since it is not practical to access huge volume of data (8 KB -
32 KB) over the command line interface, the write sizes are hardcoded to 256 bytes for code flash and 64 bytes
for data flash. This is a limitation in the Developer Example and not of the flash driver.

e The current Developer Example will restrict write and erase operations to certain code block regions since it
may corrupt the Developer Example code itself.

12. Developer Example: QSPI HAL driver

12.1 Introduction

The DK-S7G2 includes an external QSP1 NOR flash from Micron (N25Q256A). This chip provides 256 MB of NOR
flash with Execute-In-Place (XIP) capability. The SPI flash is mapped to the address 0x6000 0000 Hex to Ox63FF FFFF
Hex (64 MB) of the MCU address space. Since the SPI flash is 256 MB in size, it is addressed in 4 byte address mode
and accessed as 4 banks of 64 MB each.
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External QSPI device space
This MCU internal space (4-byte address)
FFFF FFFFh 64 MB x63banks _ prer
BANK switching
FO00 0000h
Set QSPLE QSPI bank 59 10 56
its of | E000 0000h
Reserved 6 hits of internal
ADDO 0000h
SDRAM
9000 0000h Exiemal address space
2000 0000 {CS area) 7000 00000 QSPlbank 5510 16
Resernved
7000 0000h Reserved
Q3PI 6500 0000h
6000 0000 QSPI register
Peripheralidata flash O P ROM window
4000 0000h (64 MB) 4000 0000N
6000 0000
QSPI bank 1510 12
SRAM 3000 0000h
| QSPI bank 11to 08
| 2000 0000h
_ 'lJ QSPI bank 07 to 04
Code flash [Configuration] 1000 0000h
Serial flash area 0000 0000 to FBFF QSPI bank 03 to 00
0000 0000k FFFFh 0000 0000h
12.2 Run the QSPI HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of

applications in t

he terminal window.

To run the QSPI HAL driver application, follow these steps:

STEP 1: Type r_qspi and press Enter to access the QSPI flash HAL sub menu. For help, type ? and press Enter.
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r_qgspi Help Menu
~ : Back to root menu
A 1 Up one menu level
open : Open the driver
close : Close the driver
pageProgram : Programs a page of QSPI with a pattern byte args: address (60000000 - 63ffffff)
pattern (80 - ff)
sectorErase : Erase a sector of QSPI flash containing the address args: address (60000000 - 6
IFFFFFT)
read : Read a page of data from QSPI flash args (input address will be aligned to the page si
ze ) args: address (60000000 - 63ffffff)
statusGet : Tells whether the QSPI flash is in middle of a write operation
bankSelect : Select the QSPI flash bank
Synopsis:-bankSelect bankid#(e - 3)
Example:-bankSelect bankid2
versionGet : Get the version of the APIs

r_qspi)l

STEP 2: Use the pageProgram command to program a page of QSPI flash by filling it with a pattern byte. (The size
of a page is 256 Bytes for this implementation of driver interface). For ease of use, the entire page containing the
address will be filled with the byte pattern for a given address. This is the behavior of the command in the Developer
Example and not of the driver itself.

3:115200baud - Tera Term V

File Edit Setup Control Window

r_qspi>open
SSP_SUCCESS
r_qspi»pageProgram address 0x60000000 pattern @xfd
SSP_SUCCESS

r_qspi)l
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STEP 3: Use the read command to read a page of data from QSPI flash. For ease of use, the entire page containing the
address will be read and displayed for a given address. This is a behavior of the Developer Example command and not
of the driver itself.

L COM3:115200baud - Tera Term VT - O *
File Edit Setup Control Window Help

r_gspi»>read address @x60000000
60000000 FD FD FD FD FD FD FD
60000010 = FD FD FD FD FD FD FD
60000020 FD FD FD FD FD FD FD
60000030 FD FD FD FD FD FD FD
60000040 = FD FD FD FD FD FD FD
60000050 FD FD FD FD FD FD FD
60000060 FD FD FD FD FD FD FD
60000070 = FD FD FD FD FD FD FD
60000080 FD FD FD FD FD FD FD
60000090 FD FD FD FD FD FD FD
60000070 = FD FD FD FD FD FD FD
60000080 FD FD FD FD FD FD FD
600000C0 FD FD FD FD FD FD FD
600000D0 = FD FD FD FD FD FD FD
600000ED FD FD FD FD FD FD FD
600000F0 FD FD FD FD FD FD FD
P_qspi>l

STEP 4: Use the erase command to erase a sector of QSPI flash. In this implementation of the driver, the sector size
is 4 KB. Passing any address within a sector will erase the whole sector.

L COM3:115200baud - Tera Term VT - O *
File Edit Setup Control Window Help

r_qgspi>sectorErase address
SSP_SUCCESS

r_gspi»>read address @x60000000
60000000 = FF FF FF FF FF FF FF
60000010 = FF FF FF FF FF FF FF
60000020 = FF FF FF FF FF FF FF
60000030 = FF FF FF FF FF FF FF
60000040 = FF FF FF FF FF FF FF
60000050 = FF FF FF FF FF FF FF
60000060 = FF FF FF FF FF FF FF
60000070 = FF FF FF FF FF FF FF
60000080 = FF FF FF FF FF FF FF
60000090 = FF FF FF FF FF FF FF
600000A0 = FF FF FF FF FF FF FF
600000B0 = FF FF FF FF FF FF FF
600000C0 = FF FF FF FF FF FF FF
600000D0 = FF FF FF FF FF FF FF
600000E0 = FF FF FF FF FF FF FF
600000F0 = FF FF FF FF FF FF FF

r_qspi )I
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STEP 5: Use the statusGet command to check the status of the QSPI erase/write. The status will return whether the
device is busy doing a write/erase cycle.

* COM3:115200baud - Tera Term VT — | e
File Edit Setup Control Window Help

r_qspi>statusGet
NO WRITE/ERASE IN PROGRESS
r‘_qspi)l

12.3 Limitations
The QSPI HAL Driver Development Example has the following limitations:

e The read and pageProgram commands are aligned to the device page size. It’s an implementation behavior of
the command line interface command and not a driver feature.

e The device supports 256 MB of memory. It can be accessed as 4 Banks of 64 MB each. The current version of the
QSPI driver allows only access to bank 0 even when the bank selects API returns success for banks 0 -3.

e To perform a successful pageProgram command, the pages must be erased first. If a pageProgram is
requested on a non-erased sector, the operation will fail, but the driver nonetheless will return success error code.
This is a limitation of the driver and not of the Developer Example application.

13. Developer Example: RTC HAL driver

13.1 Introduction

The Real Time Clock (RTC) Developer Example application uses the Low-speed on-chip oscillator as a clock source.
The application allows to set the RTC configuration parameters such as time capture, alarm and periodic interrupt from
the command line interface. Interrupts are handled by the callback function which inverts the state of the LED1 on the
DK-S7G2 board.

13.2 Run the RTC HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the RTC HAL driver application, follow these steps:

STEP 1:Type r_rtc in the terminal and press Enter to access the RTC HAL submenu. For help, type ? and press
Enter.
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L. COM3:115200baud - Tera Term VT

File Edit Setup Control Window Help

r_rtc Help Menu
~ : Back to root menu
A 1 Up one menu level
open : Open the RTC driver.
close : Close the RTC driver.
calendarTimeSet : Set calendar
Synopsis:- calendarTimeSet sec# min# hour# mdayi# month# year# start#
calendarTimeGet : Get the calendar time
calendarAlarmSet : Set alarm
Synopsis:- calendarAlarmSet sec# min# hour#
Example:- calendarAlarmSet sec3@ mind5 hourl2
calendarAlarmGet : Get the calendar alarm time.
calendarCounterStart : Start the calendar counter..
calendarCounterStop : Stop the calendar counter.
irgEnable : Enable the alarm irq
Synopsis:- irqEnable irg#(e to 2)
Example:- irgEnable irql
irgDisable : Disable the alarm irq
Synopsis:- irqgDisable irgit(@ to 2)
Example:- irgDisable irg®
periodicIrqRateSet : Set the periodic irq rate
Synopsis:- periodicIrqRateSet rate#(6 t@ 15)
Example:- periodicIrgRateSet rate7
infoGet : Gets information about the driver including the source clock
versionGet : Gets the version of API

r_rtc>calendarTimeSet sec3@ minl5 hour5 mday7 month3 yearl5 startl
SSP_SUCCESS
r_rtc}l
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STEP 3: Type calendarAlarmSet to set the alarm.

L COM3:113200baud - Tera Term VT - O x
File Edit Setup Control Window Help

r_rtc>calendarAlarmSet sec25 minl4 hour4
SSP_SUCCESS
P_Ptc)l

STEP 4: Type periodiclrgRateSet command followed by irgeEnable irql (1 for periodic).LED1 on the
DK-S7G2 board blinks with the programmed period (ratel3 for a period of 0.5 sec).

L COM3:115200baud - Tera Term VT - O =
File Edit Setup Control Window Help

r_rtc>periodicIrqRateSet rate7
SSP_SUCCESS

14. Developer Example: SCI 12C Framework

14.1 Introduction

The SCI 12C Framework Developer Example application accesses two 12C devices (1/0 expanders connected to a bank
of LEDs — see Developer Example: SCI 12C HAL driver) present on S7G2-DK board which are synchronized by the
SCI 12C Framework. The application uses two threads which operate on each slave device. After opening each 12C
slave device, each thread performs a write to the specific registers of the 12C device. The register state is displayed by
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the LEDstateasON or OFF. The threads are synchronized by the 12C framework, which causes the Red and Green LEDs
to light up synchronously.

14.2 Run the SCI I2C Framework application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the SCI 12C HAL driver application, follow these steps:

STEP 1: Type sT_12c and press Enter to get the SCI 12C Framework application menu. For Help, type ? and press
Enter.

L COM3:115200baud - Tera Term VT — ] >
File Edit Setup Control Window Help

synergy>st i2c
st _i2c>?
st _i2c Help Menu
~ : Back to root menu
Up one menu level
t : Start the application
Stop the application

STEP 2: Type start in the terminal and press Enter to start 12C sample application which toggles two sets of LEDs
via two different 12C 1/0 expanders on S7G2-DK board.

“ COM3:115200baud - Tera Term VT — O e
File Edit Setup Control Window Help

st _i2c Help Menu
- 1 Back to root menu
A 1 Up one menu level
start : Start the application
stop : Stop the application

sf_i2c>start
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STEP 3: Type stop in the terminal and press Enter to stop application which stops the toggling of LEDs.

15. Developer Example: SCI 12C HAL driver

15.1 Introduction

On the DK-S7G2 Development Kit, the SCI 12C bus is connected to an 12C controlled 1/0 expander (part
PCAL9535A). This application configures the 1/0 expander on the DK-S7G2 as a slave device. The 1/0 expander
toggles the LEDs on/off as the result of each write operation to the expander’s registers, so you can visually see the
output of the write operation. The slave address is 0x27 with 16 sub registers. For details of the I/O expander, see the
PCAL9535A datasheet.

15.2 Run the SCI I12C HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the SCI 12C HAL driver application, follow these steps:

STEP 1: Type r_sci_i2c in the terminal and press Enter to access the SCI 12C HAL submenu. For help, type ? and
press Enter.
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synergy>r_sci _i2c
r_sci i2c>»?
r_sci i2c Help Menu
~ : Back to root menu
A : Up one menu level
open : Opens the i2c device
read : Reads data from i2c device
Synopsis:- read length# restart#
example:- read length2 restartl
write : Writes to i2c device
Synopsis:- write length# restart# data#
example:- write length3 restartl data@6 FF OF
close : Closes the i2c device
versionGet : Gets the version of API
reset : Resets the driver instance

r_sci_i2c>l

STEP 2: Invoke each menu item with the corresponding arguments to exercise the APIs. The example shows the SCI
12C write operation to the command byte register6 with values HEX 0xOF and OxFF. You will see the LED lighting up
on the board as result of command output. The respective read shows the value of the registers.

3:115200baud - Tera Term V

File Edit Setup Centrol Window Help

r_sci i2c>?
r_sci i2c Help Menu

~ 1 Back to root menu

A 1 Up one menu level

open : Opens the i2c device

read : Reads data from i2c device
Synopsis:- read length# restart#
example:- read length2 restartl

write : Writes to i2c device
Synopsis:- write length# restart# data#t
example:- write length3 restartl data@6 FF OF

close : Closes the i2c device

versionGet : Gets the version of API

reset : Resets the driver instance

r_sci i2c>open

SSP_SUCCESS

r_sci i2c>write length3 restartl data®6 FF @F
SSP_SUCCESS

r_sci i2c>read length2 restartl
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16. Developer Example: Communications Framework

16.1 Introduction
The Developer Example application shows the transport-agnostic Communication Framework of the SSP.

The Console Framework used to interact with Tera Termis built on top of the Communication Framework. In this
example, we are using the USB Communications Framework built on top of USBx. It is the same instance that is used
by console framework to interact with Tera Term. This example code provides additional file transfer capabilities
between the Host PC and DK-S7G2 board using the Kermit protocol.

16.2 Communications Framework application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the Communication Framework application, follow these steps:

STEP 1: Type sT_el_ux_comms in the terminal and press Enter to access the s¥_el _ux_comms sub menu. For
help, type ? and press Enter.

. COM3:115200baud - Tera Term VT — O >
File Edit Setup Contrel Window Help

synergy>st el ux comms
st el ux comms>?
st el ux_comms Help Menu
~ 1 Back to root menu
A 1 Up one menu level
txFile : Transmit files from board to host PC(using kermit)
Synopsis:-txFile <filel>» «<file2»..<filen>
Example:-txFile sample.txt
rxFile : Receive a file from host PC to board (using kermit)

sf_el_ux_pomms)l

STEP 2: Use the rxFi le command to receive file from the DK-S7G2. Type rxFile and press Enter. The board will
then wait for the file transfer.
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L COM3:115200baud - Tera Term VT - O *
File Edit Setup Control Window Help

synergy>st el ux_comms
st el ux comms>?
st el ux comms Help Menu
~ t Back to root menu

A 1 Up one menu level

txFile : Transmit files from board to host PC(using kermit)
Synopsis:-txFile <filel> <file2>..<filen>
Example:-txFile sample.txt

rxFile : Receive a file from host PC to board (using kermit)

st el ux comms>rxFile

STEP 3: InTera Term, navigate to File>Transfer>Kermit>Send. The file explorer opens.

. COM3:115200baud - Tera Term VT - O X
File Edit Setup Contrel Window Help

Mew connection... Alt+N
Duplicate session Alt+D
Cygwin connection Alt+G
Log...

Comment to Log...
View Log

Show Log dialeg..

Send file...
Transfer » Kermit » Receive
SSH SCP... XMODEM > Get.. (using kermit)
Change directory... ¥MODEM ¥ Send...
Replay Log... ZMODEM » Finish
LogMeTT B-Plus »

Quick-VAM
TTY Record
TTY Replay
Print... Alt+P
Disconnect Alt+1
Exit Alt+Q

Exit All

STEP 4: In the file explorer, choose the file to transmit from the host PC to the board.
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File Edit Setup Control Window

L Tera Term: Kermit Send P -
”~
synergy>sf el ux_comms [ ¥ L « Desktop > example v O | Search example P
. Y x [
S'F_EJ._LIX_CGTTHH.S}? Organize = Mew folder =z - 0
st el ux comms Help | wip - ~ 5 e .
- T 4 Hame ate modifiec ype
~ 1 Back to root m "
LA Up one menu e [ YeLEnt | image_row 2/8/2016 5:20 P File
t 3 : ~ansmit - | sample 2/ Text [
_xFlie Ttan_Tlél | This BC
Synopsis: -txFi
ynop . [ Desktop
Example: -txFil
. = . =] Documents !
rxFile : Receive a :
4 Downloads
sf el ux_comms>rxFile J Music
File received successf =]| Pictures
st el ux_comms> B videos
Unsupported sf el ux c . 05(C)
sf_el_ux_gomms}ﬂ = New Volume (E3)
= Mew Volume (F:)
£F Network v £ o
Filename:|samp|e V| All™7) ~
W

STEP 5: Once the transfer has started, you can see the transfer progress window in Tera Term.

File Edit Setup Control Window Help

Filename: |New Bitmap Image.hn|
Protocol: Kermit

Packet#: 00 e .
Bytes transfered: PPNl board to host PC(using kermit)

Elapsed time:  0:06 [172.02KBfs] DAESCYR RS BBEI b

host PC to board (using kermit) [
sT_o =

File received successfully

st el ux _comms>

Unsupported st el ux _comms Command
st el ux _comms>rxFile

1

STEP 6: Once the transfer is complete, the rxFi le command will return will with a success or failure notice.
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L COM3:115200baud - Tera Term VT — O x

File Edit Setup Control Window Help
st el ux comms>rxFile

File received successfully
st el ux _comms>

STEP 7: Use the txFi le command to send the file from DK-S7G2 board to the PC. The command use is
txFile<filenamel><filename2>.

File Edit Setup Control Window Help

st el ux comms>txFile Renesas.ogg
Waiting few seconds to setup Transfer

STEP 8: In Tera Term, choose File>Transfer>Kermit>Receive.
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. COM3:115200baud - Tera Term VT - O X
File Edit Setup Control Window Help

New connection... Alt+N
Duplicate session Ll cnesas. 0gg
Cygwin connection Alt+G setup Transfer

Leg...
Comment to Log..
View Log

Show Log dialeg..

Send file...
Transfer » Kermit ¥ Receive
SSH SCP... KMODEM » Get...
Change directory... YMODEM 3 Send...
Replay Leg.. ZMODEM b Finish
LogMeTT EatlL= %

Quick-VAaM
TTY Record
TTY Replay
Print... Alt+P
Disconnect Alt+1
Exit Alt+0Q

Exit All

STEP 9: The application waits for about 10 seconds before it initiates the transfer. Once the transfer starts, the transfer
speed is displayed in the progress window.

. Tera Term: Kermit Kermit Receive
st el ux comms>txFile Renesas.ogg

aiting few seconds to setup Transfer : o
g p Filename: enesas?.o0qq

Protocol: Kermit
Packet#: 2921
Bytes transfered: 146858
Elapsed time: 0:02 [50.71KB/}s)

STEP 10: Once the transfer is closed, the transfer progress window will be closed and the console will print the status.
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L COM3:115200baud - Tera Term VT — ] b4
File Edit Setup Control Window Help

st el ux _comms>txFile Renesas.ogg
Waiting few seconds to setup Transfer
Files Transferred successfully
sf_el_ux_pomms>l

e The application uses the E-Kermit library which is licensed under the Revised 3-Clause BSD license.
e The application has only been tested using Tera Term.

e The application might not work if the file transferred is binary and contains a kermit-defined control character
sequence.

17. Developer Example: FileX Framework

17.1 Introduction

The FileX Framework is implemented with support from the Block Media Framework. The only block media device
currently supported by the SSP is the SD/MMC block device. The Developer Example uses SD/MMC as the block
media device and implements the commonly used file system APIs, which are similar to Linux commands, to
demonstrate the FileX Framework.

17.2 Run the FileX Framework application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the FileX Framework application, follow these steps:

STEP 1: Type sT_el_fx in terminal and press Enter to access the sf_el_fx sub menu. For help, type ? and press
Enter.
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COM3:115200baud - Tera Term VT

File Edit Setup Control Window Help

synergy>st el fx
st el fx>?
st el fx Help Menu
~ : Back to root menu
: Up one menu level
List the directories
Synopsis:- ls
: Cat the files and display in console
Synopsis:- cat <FILE>
Example:- cat sample.txt
Rename the files
Synopsis:- mv <OLD FILE NAME> <NEW FILE NAME>
Example:- mv filel.txt file2.txt
: Copy the files
Synopsis:- cp <FILE1l> <FILE2>
Example:- cp filel.txt file2.txt
Remove the files
Synopsis:- rm <FILE>
Example:- rm sample.txt
touch : Create the files
Synopsis:- touch <FILE>
Example:- touch sample.txt
edit : Edit the files
Synopsis:- edit <FILE> <STRING>
Example:- edit sample.txt Hello, World
mkdir : Create a directory
Synopsis:- mkdir <FOLDER NAME>
Example:- mkdir folderl
rmdir : Remove the directory
Synopsis:- rmdir <FOLDER NAME>
Example:- rmdir folderl
mvdir : Rename a directory
Synopsis:- mvdir <OLD FOLDER> <NEW FOLDER>
Example:- mvdir folderl folder2
clear : Clear screen

st el x>

STEP 2: Type the I's command to list the files and directories on the SD card.
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COM3:115200baud - Tera Term VT - O X

File Edit Setup Control Window Help

st el fx>1s

BOOT . IMX6QS

System Volume Information
audio.ogg

Renesas.ogg

image row

New Bitmap Image.bmp
sf_el_fx)l

STEP 3: Type the command cat newfFi le.txt to display the content of file in the console.

L COM3:115200baud - Tera Term VT - O >
File Edit Setup Control Window Help

st el fx>cat newfile.txt
this is simple text file
sF_el_fx)l

STEP 4: To rename the file, type the command mv newfile.txt abc.txtand Is to display.

R11ANO024EU0140 Rev.1.40 Page 43 of 108
Sep 1, 2016 RENESAS



Renesas Synergy™ Software Package (SSP) v1.1.0 Developer Examples

COM3:115200baud - Tera Term VT - O *

File Edit Setup Contrel Window Help

st el fx>mv newfile.txt abc.txt
st el fx>1s

BOOT . IMX6Q5

System Volume Information
audio.ogg

Renesas.ogg

image row

New Bitmap Image.bmp

abc.txt

sf_el_fx)l

STEP 5: To copy the files, type the command cp abc.txt newcopy.txtand Is to display
COM3:115200baud - Tera Term VT - O x

File Edit S5etup Contrel Window Help

st el fx>cp abc.txt newcopy.txt
st el fx>1s

BOOT . IMX6QS

System Volume Information
audio.ogg

Renesas.ogg

image row

newcopy . txt

New Bitmap_ Image.bmp
abc.txt
sf_el_fx)l

STEP 6: To edit a file, type the command edit newfile.txt String and use catnewfile.txt to display
the edited content.
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L COM3:115200baud - Tera Term VT

File Edit Setup Control Window Help

st el fx>edit newfile.txt this is simple text file
st el fx>cat newfile.txt

this is simple text file

sf_el_fx)l

STEP 7: To create a file, type the command touch newFile.txt. The command creates a new file, which you can
display using the I's command.

BOOT . IMX6QS
System Volume Information
audio.ogg

newcopy.txt

New Bitmap Image.bmp
abc.txt

testFolder

st el x>

st el fx>touch newFile.txt
st el x>

st el fx>1s

BOOT . IMX6QS

System Volume Information

newcopy . txt

New Bitmap Image.bmp
abc.txt

newFile.txt
testFolder
sf_el_fx)l

STEP 8: To create directory, type command mkdir newFolder.
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COM3:115200baud - Tera Term VT - O X

File Edit Setup Control Window Help

st el fx>mkdir newFolder
st el fx»>1s

BOOT . IMX6Q5

System Volume Information
audio.ogg

Renesas.ogg

image row

newcopy . txt
ew Bitmap Image.bmp

newFolder

STEP 9: To remove a directory, type command rmdir newFolder.

COM3:115200baud - Tera Term VT - O *®

File Edit Setup Control Window Help

st el fx>ls

BOOT . IMX6QS

System Volume Information
audio.ogg

Renesas.ogg

image row

newcopy.txt

New Bitmap Image.bmp
abc.txt

newFolder

st el fx>rmdir newFolder
st el fx>1s

BOOT . IMX6QS

System Volume Information
audio.ogg

Renesas.ogg

image row

newcopy . txt

New Bitmap Image.bmp
abc.txt

STEP 10: To rename a directory, type command mvdir newFoldertestFolder
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L COM3:115200baud - Tera Term VT — ] b4
File Edit Setup Control Window Help

st el fx»l1s

BOOT . IMX6QS

System Volume Information
audio.ogg

Renesas.ogg

image row

newcopy.txt

New Bitmap Image.bmp
abc.txt

newFolder

st el fx>mvdir newFolder testFolder
st el fx>1s

BOOT . IMX6QS

System Volume Information
audio.ogg

Renesas.ogg

image row

newcopy . txt

New Bitmap Image.bmp
abc.txt

testFolder

sf_el_fx)l

18. Developer Example: HAL ICU Driver

18.1 Introduction

The Developer Example demonstrates the external IRQ using the ICU HAL modules. The Developer Example uses
Port0 Pin6 configured as GPIO in Input mode to generate the External IRQ when you press button S1 on the DK-S7G2
Board. The application toggles LED1 each time you press the button.

18.2 Run the HAL ICU Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the HAL ICU driver application, follow these steps:
STEP 1: Type r_icu to get the ICU external IRQ menu. For help, type ? and press Enter.
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L COM3:115200baud - Tera Term VT — ] =
File Edit Setup Contrel Window Help

synergy>»r_icu
i ?
u Help Menu
: Back to root menu
: Up one menu level
open : Initial configuration
close : Close the ExtIRQ
enable : Enable ExtIRQ
disable : Disable ExtIRQ
triggerSet : Set trigger level
Synopsis:- triggerSet IRQ TRIG# 3-LEVEL LOW 2-BOTH EDGE 1-FALLING @-RISING
Example:- triggerSet IRQ TRIG1
filterEnable : External IRQ filter Enable
filterDisable : External IRQ filterDisable
versionGet : Gets the version of API

r icuw]

STEP 2: Type the open command to initialize the External IRQ.

. COM3:115200baud - Tera Term VT - O X
File Edit Setup Control Window Help

r_icu>open
SSP_SUCCESS
r_icuj

STEP 3: Type the enable command to enable the External IRQ.
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COM3:115200baud - Tera Term VT - O x

File Edit Setup Control Window Help

r_icu>enable
SSP_SUCCESS
r_icuj]

STEP 4: Type the triggerSet IRQ_TRIG# command to enable the trigger for External IRQ.

COM3:115200baud - Tera Term VT - O x

File Edit Setup Control Window Help

r_icu>triggerSet TRQ TRIG @
SSP_SUCCESS
r_icw]

STEP 5: Press button S1 on the DK-S7G2 Board to display the External IRQ trigger. LED1 toggles with each button
press.

19. Developer Example: Thread Monitor Framework

19.1 Introduction

The Thread Monitor(TM) uses the Watchdog Timer as a low-level driver to reset the device if any of the threads
registered in the Thread Monitor encounter an erroneous condition. The Developer Example explains how to register a
thread for monitoring and how to figure out its minimum and maximum number of executions in a given window by
enabling profiling mode.

The Developer Example uses a thread and registers this thread for monitoring with two possible arguments called
misbehave0 and misbehavel. The thread toggles green LED of LED1 for an infinite time if misbehaveO is passed as an
argument to the demo_thread_monitor command. If misbehavel is passed as an argument to
demo_thread_monitor,thethread toggles the red led of LED1 10 times and enters an erroneous condition in which
the thread locks in a while(1) loop and registered thread will not indicate thread monitor that it is active, which results
in device reset.

NOTES:

e The closeAPI of the Thread Monitor does not stop the WDT. You must refresh the WDT explicitly
otherwise the device is reset. Refer to Thread Monitor SSP limitation.

e Disconnect the JTAG while running the application in normal mode (that is the profiling mode is disabled).
Refer WDT SSP limitation.
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19.2 Build and Run the Thread Monitor Framework application

The steps required to build the application differ from the other Developer Examples because for the Thread Monitor
you must configure the thread for profiling mode in the e? studio Project Configurator using the Threads tab.

STEP 1: Extract the downloaded project source into a work directory in the host PC.

STEP 2: Launch e?studio. Navigate to File>Import. The Import dialog box opens.

6% Import e X
Select \“
Create new projects from an archive file or directory. E 5
Select an import source:
type filter text
4 (= General -
[ Archive File
[« CMSIS Pack
@ Convert CCRX to GNURX Project
Ta# DS-5 KPIT GNUARM-RZ/NONE Project
=3 Existing Projects into Workspace £
[} File System
4§ HEW Project
[ Preferences
[ Rename & Import Existing C/C++ Project into Workspace
e Renesas Common Project File
s B C/C++
> [ Code Generator
s B Vs
= G =
@ < Bacl Next > B

STEP 3: Select Existing Project into Workspace and click on Next. Browse to the root directory of the extracted
project source and click OK. If e? studio recognizes the project, it will be shown in the Projects window. Make sure
that checkbox next to it is checked and click the Finish button to import the project. (If a local working copy is

required, check Copy projects into workspace.)

[ [@#] import

|

Import Projects
Select a directory to search for existing Eclipse projects.

@) Select root directory:  Dr\source\DeveloperExamples
() Select archive file:

Projects:

L

- Browse...

Browse...

DeveloperExamples (D:\source\DeveloperExamples)

Options
[ Search for nested projects
[T] Copy projects into workspace
[C] Hide projects that already exist in the workspace
Working sets

[C] Add project to working sets

Select All
Deselect All

Finish | [ cencel

J

STEP 4: Open the configuration.xml file, select Thread Monitor module, and go to Properties to enable the profiling
mode to capture thread's minimum and maximum count.
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e C/C++ - DeveloperExample/configurationxml - e2 studio = =
File Edit Source Refactor Mavigate Search Project RenesasViews Run  Window Help
=i g\};vﬁv Bl i Iﬂvmvcvv@v{;vov(évgp - - > FLS . - |
Quick 3 [ || M@ C/C++ |lch Git A Debug 455 Synergy Configuration
Iy Project Explorer &2 = 0O g Synergy Configuration [DeveloperExample] 3 = O 5
= - 'y —
) = Threads "‘ a=
4 5 DeveloperExample Generate Project Content =
;}b Binaries —
[ Includes Threads SF_Thread_monitor_thread1 Modules |E_|
_‘g sre # 5F_Thread_monitor_thread1 " New @ Thread Moniter Framework on WDT Mew >
j— Synergy Thread Menitor Framework on WDT & g_wdt Watchdog Driver on r_wdt
= Debug g_wdt Watchdog Driver on r_wdt Remove Remove
= lib
(= script ik SF_Thread_moniter_thread2
(= synergy_cfg 5F_Thread_monitor_thread1 Objects
¢ configuration.xml
DeveloperExample Debug jlin Mew >
R7FS7TG27H2A01CBD.pincfg
v
< >
Summary |BSP | Clecks | Pins | Threads| ICU | Components
?! Problems J=| Tasks B Console [ Properties 52 | [l Memory Usage ‘@ Smart Browser < Search |
# |5 B~
Property Value
4 Common
Parameter Checking Default (BSP)
Maximum Number of Monitored Threads 5
Number of ThreadX Ticks Per Second 100
4 Meodule
Peripheral device on WDT
Profiling Mode Enabled v
Thread Monitor Thread Priority
Name Disabled
£ > £ >
STEP 5: When you run application, the min and max value are printed on the console.
L COM3:115200baud - Tera Term VT - m] X
File Edit Setup Control Window Help

1
4
1
4
1
4
1
4
1
4
1
4
1
4
1
4
1
4
1
4
1
4
1
4
1
4
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STEP 6: After getting the minimum and maximum values, set the values as count while registering the thread. If the
count is outside of the minimum and maximum values, it is considered as misbehavior. Minimum and maximum
depend on the design to design. Profiling mode helps user to get minimum and maximum count value. Once count value
is extracted using profiling mode, set the same while registering for monitoring.

Disable profiling mode in the properties tab and rebuild the project.

NOTE: The project must be run without the JTAG debugger for the WDT reset to work. The JTAG cable will be
disconnected in the following steps for this reason.

STEP 7: Clean and build the project.
STEP 8: Connect the S7G2 DK board to the host PC. Two connections are needed:
a) The JTAG debug connection to program.

b) The USB-CDC connection for console access

USB Serial

STEP 9: Power on the board. In ISDE, click on Run>Debug configurations. A new debug configuration with the
project name will be created. Click Debug.

r - «
E Debug Configuraticns &J
Create, manage, and run configurations ﬁ\
EIEE Name: Developer_Examples Debug
21 Main %5? Debugger| B Startup| [ Common | 1 Source

C/C++ Application
C/C++ Remote Application s

Debug-only Developer_Examples
GDB Hardware Debugging

GDE Simulator Debugging (SH, RL7
GHS Local C/Cs Launch Debug/Developer_Examples.elf

C/C++ Application:

DF Hardware

ng Variables... | [Search Project..| | Browse.. |

Developer_Examples Debu
_ 7 - ._ o __ Build (if required) before launching

Build configuration: | Use Active -

7 Enable auto build ) Disable aute build
® Use workspace settings Canfigure Warkspace Settings...
4 1 ]
) ) Apply Revert
Filter matched 9 of 12 items
@

STEP 10: Click Yes to switch to the Debug Perspective if you are asked.
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12

STEP 11: Click the Resume button twice so that the application starts its scheduler.

]

STEP 12: Click the Stop button and disconnect the JTAG. Press the Reset button in the board. Open Tera Term.

STEP 13: Choose the serial connection and choose the corresponding serial port.

File Edit Setup Control Window Help

Tera Term: Mew connection

O TCPAIP {C=1 ;serial port
History
Telnet
S5H SSH2
Other

22

UNSPEC

@ Serial Port:  COM3: JLink CDC UART Port [COM3] -~

Cancel Help
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COM3:115200baud - Tera Term VT - m} s

File Edit Setup Control Window Help

tEEEEEEEEEEE LSS SR EEEE R EEE L EEE R R R E R R E R T T T

Synergy Developer Example applications *

Version 1.1.0 *

Hit ? to show command list *

3 380 2 380 28 380 28 0 3 8 38 3 3 3 e 350 28 3 23 3 286 3 38 R 386 28 386 380 380 38 3 38 8 38 8 i 350 0 380 2 38 2k 8 28 i ol o ol i i R R R i e

synergy>j]

STEP 15: Type ? and press Enter to get the Help menu.
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aud - Tera Term VT

File Edit Setup Control Window

synergy>?
synergy Help Menu
help : Prints the help information for Developer Example
r_flash hp : Exercise Flash HAL APIs
r sci i2c : Exercise SCI_T2C HAL APIs
r_gpt : Exercise Timer GPT HAL APIs
r_adc : Exercise ADC HAL APIs
r_qspi : Exercise QSPI Flash HAL APIs
r_crc : Exercise CRC HAL APIs
r_dac : Exercise DAC HAL APIs
r_agt : Exercise Timer AGT HAL
r_ wdt : Exercise WDT HAL APIs
r_rtc : Exercise RTC HAL APIs
r_icu : Exercise EXTIRQ API's
r_fmi : Exercise the FMI hal API's
r_lpm : Exercise LPM HAL API's
r_ioport : Exercise IOPORT HAL API's
st _audio playback : Exercise Audio framework APIs
st i2c : Runs a I2c Framework Application
st _adc_periodic : Exercise ADC framework APIs

st _thread monitor : Runs a Thread Monitor Framework Application

st el fx : Exercise the FileX framework API's

st el ux comms : Exercise COMMS framework APIs

st _touch_panel i2c : Run I2c Touch framework Application

st _external irq : Exercise the External IRQ framework API's
st el nx comms : Runs a COMMS framework on NETX Application

synergy>]]

Developer Examples

STEP 16: Type sT_thread_monitor in terminal and press Enter to access the Thread monitor framework

submenu. For Help, type ? and press Enter.

aud - Tera Term VT

ontrol ¥

synergy>st_adc _periodic
st _adc _periodic>?
st_adc_periodic Help Menu
~ : Back to root menu
A 1 Up one menu level
open : Initialize ADC periodic framework
scanStart : Start the scan
scanStop : Stop the scan
close : Close the ADC periodic framework
versionGet : Gets the version of API

sf_adc_periodic)l

STEP 17: Run the demo_thread_monitor command with parameter misbehavel as argument. The red LED of
LED1 toggles 10 times and the LED1 turns off and the device resets. After reset LED1 lights up again.
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COM3:115200baud - Tera Term VT - O x

File Edit Setup Control Window Help

st _thread monitor>demo thread monitor misbehavel
t thread monitor >I

20. Developer Example: WDT HAL driver

20.1 Introduction

The Watchdog Timer Developer Example uses the HAL APIs for WDT with output visible via an LED on the DK-
S7G2 board.

The Developer Example demonstrates WDT functionality as follows:
e Enables LED1 (GREEN) to demonstrate that the WDT is running.
e Enables LED1 (RED) to indicate WDT is about to expire.
e Disable LED1 to indicate that the WDT has expired.
e The WDT underflow count-down will be visible on the console.

20.2 Run the WDT HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the WDT HAL driver application, follow these steps:

STEP 1: Type r_wdtin the terminal and press Enter to access the WDT HAL submenu. For help, type ? and press
Enter.
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“ COM3:115200baud - Tera Term VT — O e
File Edit Setup Control Window Help

synergy>r_wdt
r_wdt>?
r_wdt Help Menu

~ 1 Back to root menu
At Up one menu level
open : Initialize wdt unit
cfgGet : Initialize the WDT in register start mode
statusGet : Read the status of the WDT.
statusClear : Clear the status of the WDT.
counterGet : Read the current WDT counter value.
versionGet : Give the version of API
wdtDemo : Give the demo for wdt reset

r_wdt>]]

STEP 2: The open command starts the WDT (when it is in register start mode). The WDT Developer Example
application will turn on the Green LED on the DK-S7G2 board. When you execute the wdtDemo command, the
application resumes one of the sleeping thread hal_wdt_thread. The RED LED will turn on as the thread resumes. Loop
in the thread takes more than the expected time to complete and the WDT resets the device.

* COM3:115200baud - Tera Term VT - O X
File Edit Setup Control Window Help

Counter
Counter
Counter
Counter
Counter
Counter

Counter
Counter
Counter

e The thread monitor framework uses the WDT. In order to reset the device in the WDT demo, close the thread
monitor framework. If you do not close the thread monitor, it will continually refresh the WDT and it will
never reset the device.

e When using a J-Link debugger, the WDT counter does not count and therefore will not reset the device or
generate an NMI (Refer Limitations of WDT in SSP User’s Manual). To reset the device, remove the J-Link
debugger, reset the device, and then execute the steps from STEP 9 of Build and Run a Developer Example
application: Launching the terminal.
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21. Developer Example: 12C Touch Panel Framework

21.1 Introduction

The 12C Touch Panel Framework uses External IRQ (Channel 7) and SCI 12C as low level driver and Messaging
Framework to deliver the Touch Events to the respective subscribers. This Developer Example explains how to
configure 12C touch panel framework instance, External IRQ framework instance, low level 12C driver, and the
Messaging Framework in order to get touch event information from the DKS7 board. This document will also give step
by step instructions as how to invoke the Developer Example for 12C touch panel framework on a DKS7 board. 12C

Touch Panel Configuration Step

STEP 1: Open configuration.xml file, select Touch Thread, go to Properties tab, enable the Touch Thread to auto start.
Click “Generate Project Content” to update configuration file and Build the project again.

NOTE: To run the other 12C modules disable the “Auto start” thread.

[ty ProjectBxplorer 52 B G ‘ @ T = B & Synergy Configuration [DeveloperExample] &%
(5 hal_entryc Threads
|._—r) r_adc_commands.c
|._—r} r_cre_commands.c
|._—r} r_dac_commands.c Threads
|._—rhJ r_external_IRQ_commands.c
[} 1_flash_commands.c @12C P;ALZ demo thread " New
g_sf_i2c_device_breakoutboard 12C Framework Device ¢
[} r_fmi_commands.c g_i2c_breakoutboard I2C Driver on r_sci_iZc Remove

B r_ioport_commands.c

|:r] r_lpm_commands.c

|:r] r_gspi_flash_commands.c
|:r] 1_rtc_commands.c

[ r_scii2ec_commands.c

E‘] 1_timer_agt_commands.c
L—rﬂ 1_timer_gpt_cemmands.c
|._—r) r_wdt_commands.c

|._—r) r_wdt_demo_thread_entry.c
|._—r} sf_adc_demo_thread_entry.c
|._—rhJ sf_adc_dev_example.c

|._—rhJ sf_audio_dev_example.c

£ WDT HAL demo thread

& Thread monitor deme thread

2 NetX comms demo thread

|._—|‘\J sf_audio_playback_demo_thread_ent
B sf_comms_dev_example.c

E‘] sf_el_fx_dev_example.c

&3 Touch panel framework demo thread

g_sf_touch_panel_iZc Touch Panel Framework on sf_to 2
g_sf_external_touch_irq External IRQ Framework on sf_
g_i2c_touch_panel I2C Driver on r_sci_i2c ..

|:r] sf_el_nx_comms_demo_thread_entry,

|:r] sf_el_nx_comms_dev_example.c <

E'] sf_el_wx_comms_porth

[ sf_external IRQ_dev_example.c
[ sf_i2c_dev_example.c

|._—r) sf i2c_pcall_thread_entry.c
|._—r) sf i2c_pcal2_thread_entry.c

Summary BSP |Clocks Pins | Threads| ICU| Components

[T Properties 52 |I*/ Problems [&3 Pin Conflicts ) Console 4 Debug

|._—r} sf_message_cfg.c Property
|._—QJ sf_message_port.h ~ Thread
|._—rhJ sf_thread_monitor_demo_thread_ent ijymhnl
|._—|‘\J sf_thread_monitor_dev_sxample.c Starr:(e. b
|._—|‘\J sf_touch_panel_demo_thread_entry.c P f“ B size (bytes)
B sf_touch_panel_dev_example.c rierity
Auto start

[5) sf_message_cfgaml

{2 synergy
(= Debug
[ lib
(= script

= synergy cf
1

= DeveloperExample Debug,jlink

=y RTFSTG27H2A01CED.pincfg

w
< > <

Time slicing interval (ticks)

4 Generate Project Content

Touch panel framework demo thread Modules

& g_sf_touch_panel_iZc Touch Panel Framework on =f_touch |
& g_sf_external_touch_irq External IRQ Framework on sf_exten
& g_i2c_touch_panel 12C Driver on r_sci_iZc

% g_external_touch_irg External IRQ Driver on r_icu

€< >

New =

Remove

Touch panel framework demo thread Objects

New >

Remove

Value

sf_touch_panel_dema_thread
Touch panel framewaork demo thread

1024

5
B )3
1

Note:-
by default Touch Thread

is "Disabled"

STEP 2: In Touch Thread go to Touch Thread Module section and select the 12C touch panel framework and do the
following configuration as shown. Make sure the Touch Chip and Reset Pin configuration is same as in snapshot.
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Threads Touch panel framework demo thread Modules
12C PCALZ demo thread LS Mew ":Bég_sf_touch_panel_i}lc Touch Panel Framewaork on sf Mew =
9—_55—'2;—‘:'T'C:Ebrezklzztgo_ard 12C Frar_‘r‘l;work D: @ g_sf_external_touch_irg External IRQ Framework on sf
g-ice_breakouthoar MVEren fsel1se Eemess & g_i2c_touch_panel 12C Driver on r_sci_i2c FEnzes
WOT HAL demo thread & g_external_touch_irq External IRQ Driver on r_icu
&5 Thread monitor demo thread < >
Touch panel framework demo thread Objects
&2 NetX comms demo thread Mew >
Remove
Touch panel framewerk deme thread
g_sf_touch_panel_iZc Touch Panel Framework on
g_sf_external_touch_irg External IRQ) Framework o
g_i2c_touch_panel 12C Driver on r_sci_i2c ... w
< >
Summary | BSP | Clocks | Pins | Threads | ICU | Components
T Properties &3 oy e ¥ = 0
Property Value
~ Common
Parameter Checking Default (BSP)
~ Module
Mame g_sf_touch_panel_i2c
Touch Chip g_sf_touch_panel_i2c_chip_sx8654 <:
Messaging Framework Mame g_sf_message
Thread Prierity g
Hsize Pixels 200
Veize Pixels 430
Update Hz 10
Reset Pin IOPORT_PORT 07 PIN_11 < —1
Lower Level [2C API sCI
Lower Level 12C Mame g_i2c_touch_panel
Lower Level External IRC Framework AP| SF_EXTERMAL_IRC
Lower Level External IRQ Framework Mame g_sf_external_touch_irg

STEP 3: 12C Touch Framework require Messaging Framework to pass the touch event message. In order to configure
that, go to the Run menu ->External Tool->External Tool Configurations.
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onxml - 2 studic

Window Help

Resume #'6'%'5@-@:"5_ w5 e =
Suspend =t | Bg C/C++ [ar Git % Debug {8
Terminate
Disconnect emple] &
B Tracek * Generate
Step Into
Step Ower Touch panel framework demo thread Modules
Step Return 4] Mew %Eg_sf_touch_panel_i?_c Touch Panel Framework on sf_t
Run to Line 12C Frar_‘n.?\rork De 4 g_sf_external_touch_irg External IRQ Framework on sf
Use Step Filters Shift+F3 an rsel e [T & g_i2c_touch_panel 12C Diriver on r_sci_i2c
& g_external_touch_irg External IRQ Driver on r_icu
@, Run Ctrl+F11
*&, Debug F11
Run History » = =
Run As »
Run Configurations... Touch panel framework demo thread Objects
Debug History »
Debug As »
Debug Configurations...
e
| % External Tools » ‘ (no launch history)
ST SRS e O T LRSI
g_i2c_touch_panel 12C Driver « Run As >
< I External Teols Configuraticns... I (‘_I
1 ~—

Summary | BSP | Clocks | Pins | Thread

Organize Favorites...

[C] Properties 23 Problems [34 Pin Conflicts Console Debug

e =

B
il
it

The External tools configuration window displays. Select sf_message_configurator and click Run.
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E-'.e'.=_.'.':-.:."":'_.='..":- it

Create, manage, and run configurations

Run a program

O ¥ —*|,
BREER | =H 5 Mame: | sf_message_configurater |
type filter text E| Main ~. Refresh} Euild} [ -} Environmenq = Commorﬂ

w Prograrm Location: =

GL sf_message_configurator I

| ChPython2Ppython.exe

Browse Workspace... | | Browse File System... Variables...

Waoarking Directony:

| Sworkspace_loc:/S{project_name}/src/}

Browse Workspace... | | Browse File System... Variables...
Arguments:
Yworkspace_locy/ L]
S project_name}/synergy/ssp/src/framework/sf_message/sf_message_conf w
v
Appl Revert
Filter matched 2 of 2 items e e
@ Run Close
STEP 4: Click Add to configure the subscribers.
74 Messaging Framework Configuration — O >
File Help
Click on header to sort by that column
Click 'Add' to add a subscriber
Click 'Remove' to remove subscriber(s)
Click 'Save' to save the configuration XML file
Click 'Generate’ to generate data structures for the messaging framework
I
Add Remove Generate
Event Class Subscriber Instance Start (0-253) Instance End (-253)
SF_MESSAGE_EVENT_CLASS AUDIO g_sf_audic_playback_queue 1] 0
SF_MESSAGE_EVENT_CLASS TOUCH g_touch_queue
SF_MESSAGE_EVENT_CLASS_DATA g_touch_queue 0 0
74 Edit Subscriber s

Enter Event Class: IWSS_TOUCH
Enter Subscriber: W
Enter Instance Start (0-235): IID—
Enter Instance End (0-2535): IID—

Save

Event Class -> SF_MESSAGE_EVENT_CLASS_TOUCH
Subscriber ->q_touch_queue (queue created via configuration.xml).
Instance -> give zero for both start and stop.

Save and Generate; this will generate sf_message _cfg.c and sf_message_port.h file in Developer Example.
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STEP 5: In configuration.xml file, select Touch Thread and go to External IRQ diver andmake sure the following

configuration is as shown in snapshot.

Threads

##12C PCAL2 demo thread ~
g_sf_i2c_device_breakoutboard [2C Framework D¢
g_i2c_breakoutboard 12C Driver on r_sci_i2c

WOT HAL demo thread

i Thread monitor demo thread

MetX comms demo thread

Touch panel framework demo thread
g_sf_touch_panel_i2c Touch Panel Framework on
g_sf_external_touch_irq External IRQ Framework o
g_i2c_touch_panel 12C Driver on r_sci_i2c .. W

£ >

Summary | BSP | Clocks | Pins | Threads | ICU | Components

] Properties 52

Property
w Commen
Parameter Checking
v [CU
ICUIRGT
w Module
Name
Channel
Trigger
Digital Filtering

Digital Filtering Sample Cleck (Only valid when Digital Filtering is Enabled)

Interrupt enabled after initialization
Callback

MNew

Remove

Touch panel framework demo thread Modules

= g_sf_touch_panel_i2c Touch Panel Framework on sf_ty Mew =
=3 g_sf_external_teuch_irg External IRQ Framework on sf
= g_i2c_touch_panel 12C Driver on r_sci_i2c [
“+iq_external touch_irg External IRQ Driver on r_icu;
L4 >
Touch panel framework demo thread Objects
Mew =
Remove
mlE»m v =0
Value
Default (BSP)
Priority 3

g_external_touch_irg
7

Falling

Enabled

PCLK /1

True

MNULL

STEP 6: Open the Pins tab under configuration.xml and configure the PORT_00_PIN_01 and PORT_07_ PIN_11 as

shown.

Pins

Select pin configuration
R7FS7TG2TH2A01CED.pincfg

Pin Selection Pin Configuration

Generate Project Content

type filter text & | = & @
v v PO ~ Module name: POO1
v POOD .
» POD1 Symbolic name: | GPIOT
PO02 Comment: TOUCH_IRC
PDO3
Poc4 PO0T Configuration
P0O5
+ PO0B Mode: Input mode ~
Poo7 IRC IRQ7_DS v
POO3
POOS Chip input/cutput
poTO POOT: v |ario v
PO11
v P014 v
Summary |BSP | Clocks | Pins | Threads | ICU | Components
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Pins

Select pin configuration
RTF57G2TH2A01CED.pincfg

Pin Selection Pin Configuration
type filter text & | =l
v v P7 Ca Medule name:
v PT00 .
+ P70l Symbolic name:
~ P72 Comment:
v P703
7
v P704 P711 Configuration
« PT05
v PT06 Mode:
v P07
P708
PT709 Drive Capacity:
P70
Output :
v P71 utputtype
P2 Chip input/output
v PT13
P71
v P8
v P9 v

Summary | BSP | Clocks | Pins | Threads | ICU | Components

STEP 7: Select i2c driver, and check the following configuration.

Threads

g_sf_i2c_device_breakoutboard 12C Framewaork D¢
g_i2c_breakoutboard [2C Driver on r_sci_i2c

2 WDT HAL derno thread

i Thread monitor demo thread

MetX comms demo thread

Touch panel framework demo thread
g_sf_touch_panel_i2c Touch Panel Framework on
g_sf_external_touch_irq External IRC Framework o

£ >

12C PCAL? demoe thread ~

g_i2c_touch_panel [2C Driver on r_sci_i2c ... w

Summary | BSP | Clocks | Pins | Threads | ICU | Components

[ Properties &3

Property
w Commaon
Parameter Checking

Generate Project Content

& |
P711
[Grio12
TOUCH_RESET
Output mode ~
MNone
Low \/
CMOS w
¥ | GPIO ~
Touch panel framework demo thread Modules
Mew & g_sf_touch_panel_i2c Touch Panel Framework on sf_t Mew =
& g_sf_external_touch_irg External IRQ Framework on sf,
[Ewawz ":B'Eg_ilc_touch_panel 12C Driver on r_sci_i2c! T
& g_external_touch_irq External IRC Driver on r_icu
£ >
Touch panel framework demo thread Objects
Mew =
Remove
mE®»E =0

Value

Default (BSP)

w ICU
SCIT R Priority 5
SCITTHI Priority 5
SCITTEI Priority 5
SCIT ERI Priarity 5
~ Module
Mame g_i2c_touch_panel
Channel T
Rate Standard
Slave Address Owd8
Address Mode 7-Bit
Callback MNULL
NOTE: The address of i2c touch device ic is 0x48.
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21.2 Run the 12C Touch Panel Framework application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the 12C Touch Panel Framework application, follow these steps:

STEP 1: type sf_touch_panel _i2c interminal and press Enter to access the 12C Touch Panel framework sub-
menu. For Help, type "?"and press Enter.

- COM3:115200baud - Tera Terrn VT — O >
File Edit Setup Contrel Window Help

synergy>st_ touch_panel i2c
st_touch_panel i2c>?
st touch panel i2c Help Menu
: Back to root menu
: Up one menu level
: Start scanning for touch events.
: Stop the scanning

sf_touch_panel_iZc)I

STEP 2: Enter the start command and touch the Touch Panel.

NOTE: For the sf_touchpanel_12C framework to work properly there should be a touch event between stop and
start command, for example, stop ><touch>-> start. However start ><touch>-> start isa
valid combination and would cause the touch event to be generated. This is how the framework is implemented by the
SSP and it is not a limitation of the Developer Example.
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. COM3:115200baud - Tera Term VT
File Edit Setup Control Window Help

st _touch_panel i2c
touch panel start -

st touch panel i2c»>x: 282, y: 225, event: SF_TOUCH_PANEL EVENT DOWN

st _touch panel i2c>start

touch panel start --SSP_SUCCESS

x: 800, y: 480, event: SF_TOUCH_PANEL_EVENT_DOWN
x: 282, y: 225, event: SF_TOUCH_PANEL_EVENT_UP
st_touch_panel i2c>x: 166, y: 164, event: SF_TOUCH_PANEL_EVENT_DOWN
147, y: 109, event: SF_TOUCH_ PANEL_EVENT_UP
208, 115, event: SF_TOUCH_PANEL_EVENT_DOWN
208, 110, event: SF_TOUCH_PANEL_EVENT UP
208, 149, event: SF_TOUCH_PANEL_EVENT DOWN
213, 214, event: SF_TOUCH PANEL_EVENT UP
192, 203, event: SF_TOUCH_PANEL_EVENT DOWN
213, 214, event: SF_TOUCH PANEL EVENT UP
208, 182, event: SF_TOUCH_PANEL_EVENT DOWN
209, 165, event: SF_TOUCH PANEL EVENT UP

3

b A S

Hl X X X X X X X

STEP 3: In order to stop touch sensing enter the Stop command

L COM3Z:115200baud - Tera Term VT

File Edit Setup Control Window Help

266, y: 269, event: SF_TOUCH_PANEL_EVENT DOWN
265, y: 269, event: SF_TOUCH PANEL EVENT UP
228, 250, event: SF_TOUCH PANEL_EVENT DOWN
227, y: 251, event: SF_TOUCH PANEL EVENT UP
211, 225, event: SF_TOUCH PANEL_EVENT DOWN
190, 161, event: SF_TOUCH PANEL_EVENT MOVE
286, y: 156, event: SF_TOUCH PANEL EVENT UP
256, 187, event: SF_TOUCH PANEL_EVENT DOWN
286, y: 156, event: SF_TOUCH PANEL_EVENT UP
309, 216, event: SF_TOUCH PANEL_EVENT DOWN
340, 223, event: SF TOUCH PANEL_ EVENT UP
265, y: 214, event: SF_TOUCH PANEL EVENT DOWN
244, 278, event: SF TOUCH PANEL EVENT UP
220, y: 243, event: SF_TOUCH PANEL_EVENT DOWN
226, 250, event: SF_TOUCH PANEL_EVENT UP
265, 265, event: SF_TOUCH PANEL_EVENT DOWN
264, y: 267, event: SF_TOUCH PANEL_EVENT UP
292, 191, event: SF_TOUCH PANEL_EVENT DOWN
264, y: 267, event: SF_TOUCH_PANEL EVENT UP
329, 173, event: SF_TOUCH PANEL_EVENT DOWN
328, 180, event: SF_TOUCH PANEL_ EVENT UP
342, y: 186, event: SF_TOUCH PANEL EVENT DOWN
294, 183, event: SF_TOUCH PANEL_EVENT UP

<

KX X XXX XX XXX XX XXX XX X X X XX
TS gggg i

st _touch panel i2c>stop
touch panel stop - ' SUCCESS
sf_touch_panel i2c>]
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22. Developer Example: FMI HAL driver

22.1 Introduction

The FMI HAL Interface is a generic API for reading records from the Factory MCU Information flash table. The
Developer Example demonstrates the FMI HAL by displaying the MCU information onto the console.

22.2 Run the FMI HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the FMI HAL driver application, follow these steps:

STEP 1: Type r_fmi in the terminal and press Enter to access the FMI HAL submenu. For help, type ? and press
Enter.

“ COM3:115200baud - Tera Term VT — [m} e
File Edit Setup Control Window Help

synergy>r_fmi
r_fmi>?
r_fmi Help Menu
~ ! Back to root menu
A 1 Up one menu level
productInfoGet : Open the External IRQ instance
versionGet : Gets the Version of the API

r_fmi>]]

STEP 2: Type productinfoGet command to get the details of the device.
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“ COM3:115200baud - Tera Term VT — O e
File Edit Setup Control Window Help

r_fmi>productInfoGet
SSP_SUCCESS

variant = 14
major
minor
unique id = 7c 73 4 20 30 30 31 47 38 4e ea cf 97 1le 54 54
product name = R7FS7G27H2A@1CBD

product marking = WS1441A100

mask revision = 2

pin count = 224

package type = 2

temperature range is -40'C to 85'C

quality code = @

maximum frequency = 240MHz

r_fmi>]]

0
1
0

23. Developer Example: LPM HAL driver

23.1 Introduction

The Developer Example demonstrates the LPM HAL driver APIs. LPM module is used to put device to sleep, software
standby and deep software standby mode. It is also possible to stop or start any module.

23.2 Run the LPM HAL driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the LPM HAL driver application, follow these steps:

STEP 1: Type r_Ipm in the terminal and press Enter to access the LPMHAL submenu. For help, type ? and press
Enter.
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ud - Tera Term VT

ntrol - Window  Help

~ 1 Back to root menu
A 1 Up one menu level
init : Open the LPM driver module Initialized the LPM
mstpcrSet : Set value of MSTPCRs
Synopsis:- mstpcrSet modA# modB# modC# modD#
mstpcrGet : Get the values of all the Module Stop Control Registers
moduleStop : Stop a module
moduleStart : Run a module
operatingPowerModeSet : Set power mode
Synopsis:- operatingPowerModeSet modei(0-3) subosc#(0-1)
snoozeEnable : Config & enable snooze
Synopsis:- snoozeEnable rxdi#t dtc# request# triggertt
snoozeDisable : Disable snooze mode
lowPowerCfg : Config low power mode
Synopsis:- lowPowerCfg modeit enable# power# port#
wupenSet : Set value of WakeUp Interrupt Enable Register
Synopsis:- wupenSet value#
wupenGet : Get the value of WakeUp Interrupt Enable Register
deepStandbyCancelRequestEnable : Enable Deep Standby
Synopsis:- deepStandbyCancelRequestEnable pin# edge#
deepStandbyCancelRequestDisable : Disable Deep Standby
Synopsis:- deepStandbyCancelRequestDisable pini#
enterLowPowerMode : Enter low power mode
versionGet : Get the driver version based on compile time macros

r_lpm)l

STEP 2: To stop a module type moduleStop command. To validate we can use mstpcrGet command before and
after executing modu leStop command. In the below picture SCI7 is stopped, which can be noticed by the value in the
mstpcrb value. For example, mstpcrb value before stopping SCI7 was Oxfeffo7bf and after stopping SCI17 is Oxffffb7bf

oxFfbffflc
Oxfeffb7bf
OXFFFFOFFf
oxffefffdf

oxFfbffflc
OxFFFfb7bf
OXFFFFOFFf
oxffefffdf
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STEP 3: To stop a module type moduleStart command. To validate you can use mstpcrGet command before and
after executing moduleStart command. In the below picture SCI7 is started, which can be noticed by the value in
the mstpcrb value. For example, mstpcrb value before starting SCI7 was Oxffffb7bf and after starting SCI7 is
Oxfeffb7bf.

COM3:115200baud - Tera Term VT - O *

File Edit Setup Control Window Help

r_lpm>mstpcrGet
SSP_SUCCESS
mstpcra_value oxffbfffic
mstpcrb_value Oxftfffb7bf
mstpcrc value Oxffffbfff
mstpcrd value Oxftfefffdf
r_lpm>moduleStart
select which module to start
QSPI
v
CAC
CRC

exffbfffic
mstpcrb_value Oxfteffb7bf
mstpcrc_value Oxftfffbfff
mstpcrd value oxffefffdf
r_lpm)l

STEP 4: To set operating mode type operatingPowerModeSet command.

“ COM3:115200baud - Tera Term VT — O e
File Edit Setup Control Window Help

r_lpm>operatingPowerModeSet model subosc@
SSP_SUCCESS
r_lpm)l

STEP 5: To snooze an interrupt in a low power mode execute following commands sequentially.
1. snoozeEnable
2. lowPowerCfg

3. enterLowPowerMode
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- COM3:115200baud - Tera Term VT — O b
File Edit Setup Control Window Help

r_lpm>snoozeEnable rxd® dtc® request2 triggerl
SSP_SUCCESS

r_lpm>lowPowerCfg model enablel power2 portl
SSP_SUCCESS

r_lpm>enterLowPowerMode

SSP_SUCCESS

r‘_lpm)l

e moduleStart and moduleStop command allows only QSPI, SCI17, CAC, CRC, AGT1 and AGTO
modules to start and stop respectively. This is not the limitation of SSP.

o IfSRAM is put to sleep it resets board and if USBFS is put to sleep it blocks the console so Developer
Example restricts user to put certain modules like SRAM and USBFS into sleep.

e To set the device into the low power mode, user needs to run lowPowerCfg command followed by
enterLowPowerMode command.

24. Developer Example: External IRQ Framework

24.1 Introduction

The External IRQ Framework uses External IRQ HAL module as a low level driver and waits for the user to give an
external interrupt. In Developer Example, switch S2 is configured as a source of external IRQ. When the wait
command is executed, the thread waits for an external IRQ, which can be given by pressing switch S2. The External
IRQ Framework is integrated to CLI in Developer example from which all the APls of External IRQ can be exercised.

24.2 Run the External IRQ Framework application
The following are the steps to configure switch S2 for an External IRQ HAL driver.
NOTE: In S7TG2-DK V2.2 switch S2 is connected to PO_10 with IRQ channel 14.

The screen shot below shows the property of an external IRQ HAL module mapped to external IRQ framework.
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{8t *Synergy Configuration [DeveloperBxample] 52

Threads

Threads

.‘??HALr'Common ~
g_cgc CGEC Driver on r_cge
g_elc ELC Driver on r_elc
g_ioport [0 Port Driver on r_icport ...
Developer Example Thread
g_sf_console Console Framework on sf_cons
g_sf_comms Communications Framework o
g_ux_device_class_cdc_acm USBX Device Clz
& Audic Playback demo thread
g_sf_audio_playback Audio Playback Frame
g_sf_audio_playback_queue Queue
audio_semaphore Semaphore
& ADC framework demo thread
g_sf_adc_periodic SF_ADC_Periodic on SF_AI
g_adc_frame ADC Driver on r_adc
g_transfer_frame Transfer Driver on r_dtc 5o
12C PCALT demo thread
g_sf_iZc_device_mainboard [2C Framework [
g_izc_mainbeoard 12C Driver on r_sci_iZc

12C PCAL2 demo thread
g_sf_i2c_device_breakoutboard 12C Framewt

n 120 hreaknothnard 120 Nriver nn e sl 12e
£ >

Summary | BSP | Clocks | Pins | Threads | ICU | Components

] Properties &3

Property
4 Commeoen
Parameter Checking
4 ICU
ICUIRC14
4 Module
MName
Channel
Trigger
Digital Filtering

Mew

Remowve

Value

Default (BSP)
Pricrity &

g_external_irg1
14

Falling
Disabled

Digital Filtering Sample Clock (Only valid when Digital PCLK / 64

Interrupt enabled after initialization
Callback

True
MULL

= g
o

Generate Project Content

Developer Example Thread Modules

& g_external_irg External IRQ Driver on r_icu

P g_timer_agt Timer Driver on r_agt

4 g_wdt Watchdog Driver on r_wdt

$ g_sf_thread_monitor Thread Monitor Framew
¥ g_lpm Low Power Modes Driver on lpm

4 g_sf_external_irq External IRC} Framewerk on <
|":B§g_afternal_irq1 External IRC Driver on r_icu:

& q fmi FMI Driver on r fmi
< >

Developer Example Thread Objects

@ g_touch_queue Queue

i)
T

4

Mew =

Remove

MNew =

Remove

The screen shot below shows the pin configuration made for switch S2.
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{8k *Synergy Configuration [DeveloperExample] 53 = O

Pins 0o

Generate Project Content

Select pin configuration
R7FS7G2TH2ADICED. pincfg v

Pin Selection Pin Configuration
type filter text 4 + = .j'| o
4 v Ports ~ Module name: P00
4 + PO .
+ POOD Symbolic name: GPIO15
« POD1 Comment; switch 2 is configured
P02
PO03 P00 Configuration
POO4
POD5 Mode: Input mode v
« PO0G Pull up: None v
POO7
POO3 CMOS
POO9
IRC: IRQ14_DS v
« PO10 @ —
PO Chip input/output
« P04
POT5 PO10: ¥ | GPIO v
« P1
< P2
« P3
«+ P4
v P53
« PB v < >

Summary | BSP | Clocks | Pins | Threads | ICU | Components

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the External IRQ Framework application, follow these steps:

STEP 1: Type sf_external _irq in the terminal and press Enter to access the External IRQ Framework submenu.
For help, type ? and press Enter.
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“ COM3:115200baud - Tera Term VT — [m} e
File Edit Setup Control Window Help

synergy>st_external irq
st _external irg>?
st _external irq Help Menu
~ 1 Back to root menu

A 1 Up one menu level

open : Open the External IRQ instance

wait : Wait for IRQ till timeout i.e wait till switch2 is pressed
close : Close the External IRQ instance

versionGet : Gets the Version of the API

sf_external_irq)l

STEP 2: To wait for an external IRQevent, type open command followed by the wait command. Once the wait
command is executed a message is displayed on console and LED1 turns ON indicating it is waiting for external input.
Press switch S2 to generate external interrupt.

* COM3:115200baud - Tera Term VT - O e
File Edit Setup Contrel Window Help

sf_external irg>open
SSP_SUCCESS
st _external irgrwait

~ess switch2 to exit from wait

25. Developer Example: IOPort HAL driver

25.1 Introduction

IOPort HAL Developer Example will demonstrate 10Ports HAL module and exercises the API’s of IOPort HAL. This
Developer Example uses only 4 pins of port8 (Pin7,8,9,10) to demonstrate the 10 functionality andExercising the HAL
API’s of IOPort module. Other pins are mapped to different peripherals and hence not used.

25.2 Run the IOPort HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.
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To run the HAL 10Port driver application, follow these steps:

STEP 1: Type r_ioport in terminal and press Enter to access the r_ioportsub menu. For help, type ? and press Enter.

r_ ioport>?
r_ioport Help Menu

~ : Back to root menu

© : OUp one menu level

pinRead : Reads wvalue of pin Input: port{0-11) pin{(0-15)
Synopsi=:- pinRead port# pin#
Example: - pinRead port8 pin7

pinWrite : Write=s to pin Input: pin(0-3) lewel (0-1)
Synopsis:- pinWrite ping level#$
Example:- pinWrite pinl lewvell

pinDirectionSet : Sets direction of pin Imput: pin(0-3) dir(0-1)
Synopsis:- pinDirectionSet pin# dir#
Example:— pinDirectionSet pinl dir0

portRead : Reads from a port Input: port {0-11)
Synopsis=:- portRead port#
Example: - portRead port2

pinCfg : Configure the pin Input: pin{(0-3)
Synopsis:- pinCfg pin# cfg#
Example: - pinCfg pinl cfg4

pinEventInputRead : Read the input data of pin Input: pin(0-3)
Synopsi=z:- pinEventInputRead pin#
Example: - pinEventInputRead pinl

pinEventOutputWrite @: Write pin event Input: pin(0-32) wal(0-1)
Synopsis:- pinEventOutputWrite ping val#
Example: - pinEventOutputWrite pinl wvald

portDirectionSet : Sets direction of port Imput: port(8) dir(0-1)
Synopsis:- portDirectionSet port# dir#
Example:— portDirectionSet portg& dirl

portEventInputRead : Read the input data of port Input: port{0-11)
Synopsis=s:- portEventInputRead port#
Example: - portEventInputRead portl

portEventOutputWrite : Write port event Imput: port (8)
Synopsis:- portEventOutputWrite portc# data#
Example: - portEventOutputWrite portf datal

portWrite : Writes to a port Input: port(8)
Synopsis:- portWrite port# data#
Example: - portWrite portd8 datal

ethernetModeConfig : Configure the PHY mode of the Ethernet channels Input:channel (0-1) mode (0-1)
Synopsis:- ethernetModeConfig channelf mode#

wvergionGet : Give the wversion of APT
Example:— wersionGet

STEP 2: Type pinRead or portRead command it will display selected pin or port value in terminal.

File Edit Setup Cont

r ioport>pinRead portl piné

IOPORT_LEVEL_HIGH

r ioport>portRead port2
value = O0=x30ff

r_ioport>l
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STEP 3: Type pinWrite or portWrite command to update a value to the specific pin or port.

COM4:9600baud - Tera Term VT — O *

File Edit Setup Control Window Help

STEP 4: Type pinDirectionSet or portDirectionSet command to set direction of particular pin or port.

COM4:9600baud - Tera Term VT - O ®

File Edit Setup Contrel Window Help

iDirectionSet pinl dir0

~tDirectionSet port8 dirl
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STEP 5: Type pinEventlnputRead or portEventlInputRead command to read the event input data of
specific pin or port.

COM4:9600baud - Tera Term VT — O *

File Edit Setup Control Window Help

STEP 6: Type pinEventOutputWrite or portEventOutputWrite command to write the event output data
value to a pin or port.

2. COM4:9600baud - Tera Term VT — O 4
File Edit Setup Control Window Help

inEventCutputWrite pinl wvall

yrtEventOutputWrite port8 datal

STEP 7: Type pinCfg command to configure the setting of a pin.
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COM4:9600baud - Tera Term VT - O hs

File Edit Setup Control Window Help

inCfg pinl cfg4

STEP 8: Type etherNetModeConfig command to configure Ethernet channel in PHY mode.

COM4:9600baud - Tera Term VT - O ®

File Edit Setup Control Window Help

rartrethernetModeConfig channell model

NOTES:

e Itis recommended to reset the board before using for any other module.

e The Init command will reinitialize all the pins and console will not respond to any input hence not used.
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26. Developer Example: Telnet Communications Framework

26.1 Introduction

This Developer Example uses the Telnet Communication Framework that uses NetX IPv4 TCP/IP Stack. The purpose
This Telnet Communication example will demonstrate an echo server, which echo back the characters typed by you on
the console.

26.2 Telnet Communication Configuration Steps
To create a Telnet application, you have to make some configuration in configuration.xml file as shown below.

STEP 1: Open configuration.xml file, NetX comms demo thread and disable auto start.

[ Project Explorer 2 = B | Synergy Configuration [DeveloperExample] &2 =08 z ™» =0
BE|e < Threads 0o L
7} r-wit_commands.c " Generate Project Content | An outline is not
[} r_wdt_demo_thread_entry.c available.
[£) =F ade_demo_thread_entry.c Threads NetX comms demo thread Modules
(£} sf_sdc_dev_example.c %2 Thread monitor demo thread ~ New e
[#) sf_sudie_dev_example.c
[#) sf_sudie_playback_demo_thread Pz E—
[ scomms devoomplec ||
7} sf_el_fx_dev_semple.c 4 NetX comms demo thread
(5} sf_el_nx_comms_demo_threagl_e
[ sf_el_nx_comms_dev_example.c
(8 of el ux comms_porth & Touch panel framewark demo thread NetX comms demo thread Objects
5} =f extemal IRQ, dev example.c g of touch_panel i2c Touch Panel Framewsrk on sf touck
[} sf_i2c_dev_example.c g_sf_external_touch_irgq External IRQ Framework on sf_exte New >
E-a sf_i2c_peall_thread_entry.c |_i2c_touch_panel 12C Driver on r_sci_i2c ...
[} sf_i2c_pcal2_thread_entry.c femoe
[7) sf_message_cfg.c
[R) sf_message_porth v
[} sf_thread_moniter_demo_thread < >
[} sf_thread_monitor_dev_example,
(£} <f_touch_panel demo_thread_en | Summary BSP Clocks | Pins Threads|ICU| Components
[} sf_touch_panel_dev_sxample.c . -
[} =f message_cfgaml [ Properties 2 [i] ME S ¥ o
58 synergy Property Value
(= Debug ~ Thread
iy lib Symbol sf_el_nx_comms_dema_thread
(= seript Name NetX comms demo thread
& synergy_cfg Stack size (bytes) 1024
£ configurationaxml <: 1 Prierity 12
5 Developerfiamele Dendadink fusto start 3
< > Time slicing interval (ticks) 7

STEP 2: In Developer Example thread, g_sf comms_telnet Communications Framework instance. Change the
following fields.

o
lEad 1 Generate Project Content
V; "
Threads 2 Developer Example Thread Modules
i Developer Example Thread - A New Fg_sf_comms_telnet Communications Framework on sf_el Mew =
g_sf_console Console F_rarrjlework on sf_console 4 g nx telnet server MetX Telnet Server on nx telnet server ¥
g_sf_comms Cemmunications Framework on sf_el_ux_o Remove r > Remove
g_ux_device_class_cdc_acm USBX Device Class CDC ACN
&3 Audio Playback demo thread Developer Example Thread Objects
g_sf_audio_playback Audio Playback Framework on sf_a
g_sf._audio_pl.a)rbac_k_que.ue Cueue | @ g_touch_queue Queue New » v
Summary |B5P | Clocks | Pins | Threads | ICU | Components
[ Properties 5% o e
Property Value
v Common
Parameter Checking Default (BSP)
v Module
Name g_sf_comms_telnet<: 3
Lower Level Mame g_nx_telnet_server
Lower Level Driver Name g_sf_el_nx
Channel 4 $ 1
IP Address Byte 1 0
IP Address Byte 2 75 <: 5
IP Address Byte 3 70
IP Address Byte 4 E)l
Subnet Mask Byte 1 255
Subnet Mask Byte 2 6 E> 255
Subnet Mask Byte 3 253
Subnet Mask Byte 4 0
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STEP 3: In the Developer Example thread, g_sf_el_nx Framework instance, enable the EDMAC1 EINT as shown and

give a priority (say 10).

[ Properties &3

Property
~ Common
Parameter Checking
Channel 0 Phy Reset Pin
Channel 0 MAC Address High Bits
Channel 0 MAC Address Low Bits
Channel 1 Phy Reset Pin
Channel 1 MAC Address High Bits
Channel 1 MAC Address Low Bits
MNurmber of Receive Buffer Descriptors
MNurnber of Transmit Buffer Descriptors
~ ICU
EDMACT EINT
v Module
MName
Channel
~ Pins
ETT_EXOUT
ETT_LINKSTA
ET1_MDC
ET1_MDIO
ET1_WOL
REF50CK1
RMIN_CR5_DV
RMINT_RXDO
RMIN_RXD1
RMIIT RX ER

26.3

mlE» = v =0
Value
Default (BSP)
|IOPORT_PORT_O
(Ox00002E09
0xDADDTECT
|IOPORT_PORT_O
(OnD00D02EQY
CxDADD7ECE
g
32

2
C— = Priority 10

g_sf_el_nx
@1
P713
PBOT
P403
P404
PBOG
P70
P703
P02
P703
P04

Threads

Threads

£ HAL/Common
g_cgc CGC Driver
g_elc ELC Driver ¢
g_ioport |0 Port
i Developer Example
g_sf_console Con
g_sf_comms Cor
g_ux_device_class
4 Audio Playback de
g_sf_audio_playhi
g_sf_audio_playbi
audie_semaphore
i ADC framework de
g_sf_adc_periodic
g_adc_frame AD(
g_transfer_frame’
2 12C PCALT demo tl
g_sf_i2c_device_n
g_i2c_mainboard

i 12C PCAL2 demo tl
g_sf_i2c_device_b

~

g_i2c_breakoutbo v

£ >

MNew

Remove

2% Synergy Configuration [DeveloperExample] &2

1

= g
o

Generate Project Content

Developer Example Thread Modules

+g_|pm Low Power Mew >
& g_sf_external_irg E:
& g_edernal_irgl Bt
@ g_fmi FMI Driver o
& g_sf_comms_telne

Remove

& g_nx_telnet_server
@ g_rx NetX on nx

=>.+ g_sf_el_nx Net¥ Po
< >

Developer Example Thread Objects

@ g_touch_queue Queu MNew =

< >

Summary | BSP | Clocks | Pins | Threads | ICU | Compeonents

Run the Communications Framework application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of

applications in the terminal window.

STEP 1: Type sT_el_nx_comms in the terminal and press Enter to access the sf_el _nx_comms sub menu. For

Help, type ? and press Enter.

COM4:9600baud - Tera Term VT

File Edit Setup Control

sf el nx comms ‘-l

Window Help

STEP 2: Use start command to start the application.
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L COM4:96D0baud - Tera Term VT - O >
File Edit Setup Control Window Help

X COMMS>SCart
Started
o the Telnet server
- '-._cr:nrn.rnsbl

STEP 3: In Tera Term, navigate to File>New connection.

L COM4:9600baud - Tera Term VT — O x>
File Edit Setup Control Window Help

New connection... Alt+N
Duplicate session Alt+D
Cygwin connection Alt+G
Leg..

Comment to Log...

View Log

Show Log dialog...

Send file...

Transfer »
SSHSCP...

Change directory...

Replay Log...

TTY Record

TTY Replay

Print... Alt+P

Disconnect Alt+]
Exit Alt+Q)
Exit All

STEP 4: Select Telnet and give the IP address which is assigned to the device by configuration.xml file in the Host
field and click OK.
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X COmmS»Start
on Started
. Server
cr:nrn.rus.‘rD Tera Term: Mew connection

@® TCPHIP Host: [10.75.70.212 v
] History
Service: ® Telnet TCP port:
(O SSH SSH version: SSH2
O Other

Protocol: UNSPEC -

Serial

Cancel

STEP 5: A new window opens which work as an ‘Echo Server’. The TELNET console will echo back given inputs, in
this case Telnet App Demo is written to console which is echoed back and visible in terminal

L 10.75.70.212:23 - Tera Term VT

Setup  Control  Window Help

Telnet 2 Demo)
=f el nx comms>55E re I

SSP_SUCCESS
SP_SUCCESS
SSP_SUCCESS
SSP_SUCCESS
SSP_SUCCESS
SSP_SUCCESS
SSP_SUCCESS
SSP_SUCCESS
" SUCCESS
SUCCESS

" SUCCESS

' SUCCESS

STEP 6: Type stop in serial console to stop the application.
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COM&:8600baud - Tera Term VT — O *

File Edit Setup Centrol Window Help

NOTES:
e ltis preferable to give static IP address to the server.

e The given IP address to the device should match the default Gateway address and domain name of the system.
27. Developer Example: Power Profiles Framework

27.1 Introduction

The power profiles framework supports run, RTC and external mode of operation. The Developer Example uses
external mode, where switch S2 is configured and used as an external source to wake device from sleep. When sleep
command is executed red LED1 glows indicating device has been put to software standby mode. Once switch S2 is
pressed device wakes up and this is indicated by turning LED1 from red to green.

27.2 Run the Power Profiles Framework application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the Power Profiles Framework driver application, follow these steps:

STEP 1: Type sf_power_profiles in the terminal and press Enter to access the Power Profiles Framework
submenu. For Help, type ‘?” and press Enter.
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. COM3:115200baud - Tera Term VT - O x
File Edit Setup Control Window Help

synergy>st_power_profiles
sf_power_profiles>?
st _power profiles Help Menu
~ : Back to root menu
~ 1 Up one menu level
open : Open Power Profiles instance and enable External IRQ switch 52
sleep : Places the MCU in Software Standby mode

close : Closes channel at HAL layer and External IRQ switch S2
versionGet : Stores version information in provided pointer

sf_power_profiles)l

STEP 2: Use the open and then sleep command to configure and enter the device into software standby mode. Red
LED1 glows will indicate device entered software standby mode. Press switch S2 to wake up the device, LED1 turns
from red to green indicating the state change. This is indicated by turning LED1 from red to green.

S COM3:115200baud - Tera Term VT — O s
File Edit Setup Control Window Help

st_power profiles>open
SSP_SUCCESS

st _power profiles>sleep
SSP_SUCCESS

st _power profiles>close
SSP_SUCCESS
sf_power_profiles)l

28. Developer Example: SCI SPI HAL Driver

28.1 Introduction

This Developer Example exercises the SCI SPI HAL APIs using the on board Bluetooth Low Energy (BLE) device.
The BLE device is connected to the SCI Channel 5.

28.2 SCI SPI HAL driver configuration steps
To exercise a SPI HAL driver you need to make some configuration in configuration.xml file as mentioned below.

STEP 1: Open configuration.xml file, Developer Example Thread, add r_sci_spi driver and change the properties as
shown below.
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[f5 Project Explorer 32 = B | & Synergy Configuration [DeveloperExample] 53 = O
& -
SR Threads 2 9
E‘E, f_adc_demo_thread_entry.c ~ Generate Project Content
E‘E, f_adc_dev_examplec -
E‘E, sf_audio_dev_semple.c Threads Developer E le Thread Modul
E‘E, sf_audic_playback_demo_thread_¢ o p T E
& Developer Example Thread ~ New g spi 5P| Driver on 1 sci spi ~ New >

Ea sf_comms_dev_example.c g_sf_console Console Framework on sf_console w
E‘a sf_el_fx_dev_example.c g_sf_comms Communications Framewerk on s Remove < » Remove
Eﬂ f_el_mx_comms_demao_thread_en g_ux_device_class_cdc_acm USBX Device Class
Eﬂ sf_el_me_comms_dev_example.c &% Sudin Plavhack demn thread Nasralonar Exvamnla Thrasd Mhiacts v
[B) sf_el_ux_comms_porth Summary | BSP | Clocks | Pins | Threads | ICU| Components
[ sf_external_IRQ_dev_example.c
E‘E, sf i2c_dev_example.c Eer. ®#
E‘E, sf_i2c_peall_thread_entry.c
E‘E, sf_i2e_peal2_thread_entry.c Property Value
(6] sf_jpeg_dev_example.c Parameter Checking Default (BSP)
E‘E, sf_message_cfg.c v ICU
[} sf.message_porth SCI5 Rl Priority 10,
E s\f_inwsr;prnﬁlE_der_examplex SCI5 TXI Priority 10 .
fiy = slspidev_sample.c SCI5 TEI Priarity 10
[ sf_thread_monitor_demo_thread_¢ SCIS ERI Priority 10
E‘E, sf_thread_moniter_dev_example.c v Module
E‘E, sf_touch_panel_demo_thread_entr Name q_spi
E‘E, sf_touch_panel_dev_example.c Channel 5_ 5
I:E' sf_message_cfgxml Operating Mode Master

g E)'I’Lefgy Clock Phase Data sampling on even edge, data variation on odd edge <:| [

=aug Clock Polarity Low when idle

&y lib Mode Fault Error Disable

& script ! Bit Order MSB First

(& synergy_cfg Bitrate 4000000 7

W) > configurationyml v Callback NULL

< > £

STEP 2: Next in the same Developer Example thread, SCI common, properties enable Simple SPI mode.

48 Synergy Configuration [DeveloperExample] 3 = 8
Threads
Generate Project Content
Threads Developer Example Thread Modules
g;*HALr'Common -~ Mew wer on r_sci_i2c -~ Mew =
g_cgec CGC Driver on r_cgec 1
g_elc ELC Driver on r_elc Remuowve r - . Remowve
g_ioport IFO Port Driver on r_ioport ... ':B g_tlmer_h.al Tlmer Driver on r_gpt
i Developer Example Thread & g_fx_media FileX on fix b
g_sf_conscle Console Framework on sf_co < >
g_sf_comms Communications Framework
g_ux_dewvice_class_cdec_acm USBX Device Dewveloper Example Thread Objects
i Audio Playback demo thread
g_sf_audio_playback Audic Playback Fram ® g_touch_queue Queue Mew =
g_sf_audio_playback_queue CQueue
audio_semaphore Semaphore Remowve
i ADC framework demo thread
a sf adc pericdic SF ADC Periodic on SF Y
< >
Summary B5P | Clocks | Pins | Threads | ICU | Components
] Pr... 22
Property Value
~» Common
Asychronous Mode (r_sci_uart) Disabled
Simple SPI Mode (r_sci_spi) Enabled <::|2
Simple 12C Mede (r_sci_i2c) Enabled

STEP 3: Next in the Pins tab, complete the following steps as shown below.
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{8 Synergy Configuration [DeveloperExample] 52 = B

Pins e
Generate Project Content

Select pin configuration
R7FS7G2TH2AN CBD, pincfg  ~

Pin Selection Pin Configuration

type filter text | | =

v« Peripherals <j:|“2 Module name: 5CI5
AGT
+ BUS 5CI5 Cenfiguration a

CAC_AD Operation Mode: |::> Simple SPI (MOSI/MISO/SCK/SS)
CAN

CLKOUT_COMP, Input/Cutput

CTsU CTS55_RT55_55% Meone i

« Debug
ETHER_MII RXD5_SCL5_MISO5: c + | P510 -

<

«+ ETHER_RMII SCKS: + | P50S e
GPTO
GPT1 T¥D5_5DA5_MOSI5: « | PS09 -
KEY
«+ LCD_GRAPHICS
PDC
« (5P
RIIC
R5PI
« SCI0_2 468
[ >>v v SCN357.9
5 SCIH
SCI13
« SCI5
« SCIT
SCI9
«  SDHI_MMC

ssl 1

£ @ £
£ >

Surnmary | BSP | Clocks | Pins | Threads | ICU | Components

STEP 4: Next for setting the pin direction, complete the following as shown below.

R11ANO024EU0140 Rev.1.40 Page 85 of 108
Sep 1, 2016 RENESAS



Renesas Synergy™ Software Package (SSP) v1.1.0

Developer Examples

{8 Synergy Configuration [DeveloperBxample] 53

Pins

Select pin configuration
R7FS7TG2TH2ADICBD. pincfg

Pin Selection Pin Configuration

= 8
o

Generate Project Content

type filter text 4| = & | @
v v Ports <<1: 1 [ ! S
v v PO P005 Configuration
~ PODO Mode: Input mode
+ POO1
PO02 IRC: IRQ10_DS
P0O3 R
PO04 ip input/output
v 005 <12 PODS: +|6pi0 5
« PDOE " = S
Summary |BSP | Clocks | Pins | Threads | ICU | Components
STEP 5: Do the same for Port_5 Pin_7 and Port_A Pin_5.
485 Synergy Configuration [DeveloperExample] 51 = O
o

Pins

Select pin configuration
R7FS7G2THZADICBD. pincfg

Pin Selection Pin Configuration

type filter text & | =

[Ty,

Generate Project Content

I::>v v P35 ~
« P500

1
« P51 P307 Cenfiguration
v P502 Mode: Output mode
v P303
v P304 MNone
« P303 Drive C . L
P50 rive Capacity: ow
|::> v P507 Output type: CMOS
2 v P508
~ P50 Chip input/output
v P510 PsOT: « | GPIO
P3N
W £

Sumrnary | BSP | Clocks | Pins | Threads | ICU | Components

STEP 7: Save the configuration.xml file and click Generate Project Content as shown below.
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155 Synergy Configuration [Developerbxample] &2 = O
o

Generate Project Content

Select pin configuration ﬁ

RYFSTGZTH2ADCBD pincfg  ~

Pins

Pin Selection Pin Configuration

type filter text H [E & | &
[: v PA R [ R

1 v PADD

v PADI PADS Configuration

:Eig: Mode: Output mode w <j 3
PAD4 Nene

|:> v PAOS Drive Camaci 5
2 PACE rive Capacity: ow

PACT Output type: CMOS o

« PADE

v PADG Chip input/output

+ PATD . »

PADS: v |GPIg <::| 4 v

PATT
nat1a v < >

Summary | BSP | Clocks | Pins | Threads | ICU | Components

28.3 Run the SCI SPI HAL Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

STEP 1: Type r_sci_spi in the terminal and press Enter to access the r_sci_spi sub menu. For help, type ? and
press Enter.

L COM4:115200baud - Tera Term VT - O X
File Edit Setup Control Window Help

ci_spi Help Menu

Back to root menu

Up one menu level

open : Initialize a channel for SPI communication mode
Synopsis:- open

read : Receive data from an SPI device
Synopsi read

write : Tran t data to an SPI device
Synopsis:- write

writRead : Simultanecusly transmit data to an SPI device while receiving data
from a SPI device
Synopsis: - writRead

A

close : Remove power to the SPI channel designated by thehandle and disable the
associated .
Synopsis: -

versionGet : Get e driver version based on compile time macros
Synopsis:- versionGet

r-_sci_spi>l

STEP 2: Use open command to initialize the driver.
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2 COM&:115200baud - Tera Term VT — O =
File Edit Setup Control Window Help

r_sci_spi>open
UCCESS

STEP 3: Type read command to read value from the slave device.

. COM4:115200baud - Tera Term VT — O *
File Edit Setup Control Window Help

STEP 4: Type write command for writing to the slave device.
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. COM4115200baud - Tera Term VT — O >
File Edit Setup Contrel Window Help

r_sci_spiwrite
SSP_SUCCESS
F_sci_spi>l

STEP 5: Type the writRead command to simultaneously write and read to the slave device.

4 COM&115200baud - Tera Term VT — O x
File Edit Setup Control Window Help

r_sci_spi>writRead
Bx4

Bx1
Getting expected pattern
SSP_SUCCESS
F_sci_spi>l

STEP 6: Type close command to close the driver.
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. COM4:113200baud - Tera Term VT — O >
File Edit Setup Contrel Window Help

r_sci_spi>close
SSP_SUCCESS
r

_5ci_5pi>l

NOTES:

1. In Developer Example r_sci_spi the writeRead command is written as writRead command this is due to
the limitation of the console framework.

2. The configuration has to be done correctly else you will not get any response from the BLE.
3. For details of BLE see EM9301 datasheet.

29. Developer Example: SPI Framework

29.1 Introduction

SPI framework provides a thread safe mechanism to communicate between master and multiple slaves on the same SPI
channel. Since the DK-S7G2 board has only one SPI slave device, this Developer Example for SPI Framework will just
exercise the SPI Framework API’s on the slave device.

To configure the SPI Framework, you have to configure SCI SPI HAL driver first. See.SCI SP1 HAL driver
configuration steps follow the steps detailed below to configure the SPI Framework.

29.2 SPI Framework configuration steps
STEP 1: Add the SPI driver in Developer Example Thread.
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2&|s
[ sf_adc_dema_thread_entry.c

[ Project Explorer 32

[ sf_adc_dev_example.c
[} sf_audio_dev_example.c
[#) f_audic_playback_demo_thread_entry.c
[} sf_comms_dev_example.c
[ sf_el_fi_dev_example.c
[ sf_el_nx_comms_demo_thread_entry.c
[} sf_el_nx_comms_dev_example.c
[R) f_el_ux_comms_port.h
[} f_external IRQ_dev_example.c
[} sf_i2c_dev_example.c
[ sf_i2c_pcall_thread_entry.c
[} sf_i2c_pcal2_thread_entry.c
[5) f_jpeg_dev_eample.c
[} sf_message_cfg.c
[ sf_message_port.h
[5) sf_power_profile_dev_eample.c
[} » f_spi_dev_sxample.c
[ sf_thread_menitor_deme_thread_entry.c
[ sf_thread_monitor_dev_example.c
[ sf_touch_panel_dema_thread_entry.c
[#) sf_touch_panel_dev_exemple.c

[} sf_message_cfgxml
5 synergy
(= Debug
C lib
= script
(= synergy cfg
£} configurationami < —1 1
eveloperExample Debug,jlink
TECTGITHIAN CRN nincfn

<

>

=

v

= = B & Synergy Configuration [Developerbxample] 53

Threads

Threads

£FHAL/Common ~
g_cge CGC Driver en r_cge
g_elc ELC Driver on r_clc
g_ioport /0 Port Driver on r_ioport ...
 Developer Example Thread
g_sf_consele Consele Framewerk on sf_co
g_sf_comms Communications Framewark
g_ux_ device_class_cdc_acm USBX Device ¢
& Audio Playback deme thread
g_sf audio_playback Audio Playback Fram
q sf audic plavback queue Queue
< >

Summary | BSP | Clocks | Pins | Threads| ICU| Compaenents

HePr. 2 [&]

Property
+ Common
Parameter Checking
+ Module
Name
Lower Level $PI Configuration Name
Bus Mame
Chip Select Port
Chip Select Pin
Chip Select Active Level
<

Developer Example Thread Modules

Generate Project Content

New 4 g_cpi SPI Driver on r_sci_spi

A

g <f spi_device SPI Framewaork Device on sf

Remove

< 3

>

v

Developer Example Thread Objects

® g touch_queue Queue

Value

Default (BSP)

g_sf_spi_device
g.spi

g_sf spi_bus
00

00

Low

=8 | o= =8

-

An outline is not available.

New >

Remove

New >

Remove

[
i
Yt

q

STEP 2: SPI Framework requires a SP1 shared bus. Change the channel no in spi shared bus properties as shown
below. Generate the Project Content.

{8k synergy Configuration [DeveloperExample] £3

Threads 1
Threads @
ﬁ%HAUCommon ”~ MNew
g_cgc CGC Driver on r_cgc
g_elc ELC Driver on r_elc Remove
g_icport I/0 Port Driver on r_iopert ..
i Developer Example Thread
g_sf_console Console Framework on sf_co
g_sf_cemms Communications Framewaork
g_ux_device_class_cdc_acm USEX Device C
#2 Audio Playback demeo thread
g_sf_audic_playback Audio Playback Fram
g sf audio playback queue Cueue b
£ >

Surmmary | BSP | Clocks | Pins | Threads | ICU | Components

Bl Pr.. &2

Property
~ Common
Parameter Checking
~ Module
Mame
5Pl Implementation
Channel

29.3

HAL/Common Modules

=

=
L]

Generate Project Content

Sl

& g_sf_i2e_bus 12C Framework Shared Bus an ~

Mew =

":B‘Eg_sf_spi_bus SPIl Framework Shared Bus on

€

Remowve

>

HAL/Common Objects

&

Mew >

Remove

Value

Default (BSP)

g_sf_spi_bus
SC1SPI
s <13

Run the SPI Framework application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

To run the SPI Framework application, follow these steps:

STEP 1: Type sT_spi in the terminal and press Enter to access the sf_spi sub menu. For help, type ‘?” and press

Enter.

R11ANO024EU0140 Rev.1.40

Sep 1, 2016

RENESAS

Page 91 of 108



Renesas Synergy™ Software Package (SSP) v1.1.0 Developer Examples

COM4:115200baud - Tera Term VT - O *

File Edit Setup Control Window Help

st_spi>»?
sf_spi Help Menu
~ : Back to root menu
~ Up one menu level
Initialize a channel for SPI communication mode
Synopsis:- open
Receive data from an SPI device
Synopsis:- read
write : Transmit data to an SPI device

Synopsis:- write

writRead : Simultaneously transmit data to an SPI device while receiving data from a SPI device
Synopsis:- writRead

close : Remove power to the SPI channel designated by thehandle and disable the associated interrupts

Synopsis:- close

lock : The locking allows devices to reserve a bus(Lock the bus) to themselves for a given period
of time
Synopsis:- lock

unlock : Unlock the bus for a particular device and make the bus usable for other devices.
Synopsis:- unlock

versionGet : Get the driver version based on compile time macros
Synopsis:- versionGet

s _5pi>l

STEP 2: Type open in the terminal and press Enter to initialize the SP1 Framework.

L. COM4:115200baud - Tera Term VT - O X
File Edit Setup Control Window Help

sf_spiropen

STEP 3: Type read command in the terminal and press Enter to read data from the slave device.
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2 COM4:115200baud - Tera Term VT — | s
File Edit S5etup Control Window Help

st_spi>read

Bx

ected pattern

STEP 4: Type write command in terminal and press Enter to write data into slave device.

*. COM4:115200baud - Tera Term VT — O b4
File Edit Setup Control Window Help

sf_spidwrite

STEP 5: Type writRead command in terminal and press Enter for simultaneously write and read data from slave
device
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2 COM#:115200baud - Tera Term VT — O =
File Edit Setup Control Window Help

sf_spi>writRead

Bx

ected pattern

STEP 6: Type lock and unlock commands to respectively lock and unlock the bus for a device.

S COM&115200baud - Tera Term VT — O e
File Edit Setup Control Window Help

sf_spi>unlock
SSP_SUCCESS
5f_5pi>l

STEP 7: Type close command to close the SPI Framework.
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2 COM&:115200baud - Tera Term VT — | s
File Edit Setup Control Window Help

sf_spi>close

NOTES:

1. In Developer Example, the command to perform write-read operation is writRead. This spelling mistake is
introduced deliberately to bypass an issue with the console framework

2. Prior to the building and running the Developer Example, the configuration steps detailed in section ‘SPI
Framework configuration steps’ should be followed to configure the BLE device correctly. Any wrong
configuration will cause the device to not to respond to any of the commands.

3. During the write and write-read operations, a predetermined set of values are written to the BLE device instead
of getting the data from the user. This is because BLE device expects to receive HCI commands and writing
wrong or corrupt data might degrade the performance (or worse, cause damage) to the BLE module.

4. Developer example will exercise the write, read, and writRead API’s on BLE reset to observe the default
expected values of BLE.

5. For details about BLE see the EM9301 datasheet.
30. Developer Example: HAL JPEG Decode Driver

30.1 Introduction

The Developer Example exercises the JPEG decode driver interface to perform decode operation of a JPEG image. The
resulting decoded image will be displayed in the e? studio debug window.

30.2 JPEG Decoder Pin Configuration
In order to run HAL JPEG and JPEG Framework change the pin (P6_8) configuration as shown below.
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168 *Synergy Configuration [DeveloperExample] &3 = 0
Pins Q
Generate Project Content

Select pin configuration

R7FS7G27THZA0CED.pincfg  ~

Pin Selection Pin Configuration
type filter text + = = | a
v P2 ) Module name: P&0S
P3
v pa Symbolic name: | EXTERNAL_MEMORY_INTERFACE_A!
W
v P5 Comment:
P&00 P608 Configuration
« P&01
P02 Mode: Peripheral Mode ~
v P603 Pull up: MNone ~
~ PB04
« PE05 Drive Capacity: Low ~
« PB06
Qutput type: CMas ~
« PE07 puttyp
v P&03 Chip input/output
v P09 F :
P603: + [{A00_BCD__ADD_DOM1 f o =]
« PE10
« PE11
« PE12
« PB13
~ PE14 v
£ > £ >

Summary | BSP | Clocks | Pins | Threads | ICU | Components

30.3 Run the HAL JPEG Decode Driver application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

Stepl: Type r_jpeg in the terminal and press Enter to access the JPEG HAL submenu. For help, type “?” and press
Enter.

L COM3:115200baud - Tera Term VT - O *
File Edit Setup Control Window Help

synergy>r_jpeg
r_jpeg>?
jpeg Help Menu
~ 1 Back to root menu
A 1 Up one menu level
open : Initial configuration
outputBufferSet : Assign output buffer to JPEG codec for storing output data.
horizontalStrideSet : Configure the horizontal stride value.
Synopsis:- horizontalStrideSetit
Example: - horizontalStrideSet 800
imageSubsampleSet : Configure the horizontal and vertical subsample settings.
inputBufferSet : Assign input data buffer to JPEG codec.
linesDecodedGet : Return the number of lines decoded into the output buffer.
imageSizeGet : Retrieve image size during decoding operation.
statusGet : Retrieve current status of the JPEG codec module.
close : Cancel an outstanding operation.
versionGet : Print the current Version information of the Jpeg driver
pixelFormatGet : Get the input pixel format.

r_jpeg>fi
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Step 2: Type open in terminal to open the JPEG Driver.

“ COM3:115200baud - Tera Term VT — O e
File Edit Setup Control Window Help

r_jpeg>open

Step 3: In e? studio’s debug window go to memory tab and add the input image (inputImageBuffer) and output
image (outputImageBuffer) buffer address.

Sequence
1. Select %% Debug  prosnective

2. Select 0 Memory gy

3. Click on add button
4. Enter the address and press OK.
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File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

- [~/ - W Eix 08N SOEEE E Rt a bR R Rl Rt Ni= S i SRS AR SN S SRR -1
|| Boc B G\t-; e e T e
6" Expressi.. 32 = - = B 4 Debug & % S ‘i%> = = 8
5 B | & ,_*l et - ~ [ DeveloperExample Debug [Renesas GDB Hardware Debugging]
bt
resson e e v [ Developertiamplecti (1) .
= . 4@ Thread #11 (single core) (Running)
i ser B 8 C:/Renesas/e?_studio/DebugComp/arm-none-eabi-gdb (7.8.2)
* &img size img_size t* 0x200059€8 <img_size> -

- GDB
qr Add new expressio = server

main.c &3 = | [ Project Explorer 53 =8
5 Prog Pl
void tx_application define user(void * first unused_memory) ~ Bg|e ~
WEAK_REF_ATTRIBUTE; - T e ~
B
= void tx_application_define(void * fir‘st_unusad_memury)4 3 Binaries
2081e748 { [ Includes
8681748 dev_example_thread_create (); @ > src
0001e74c sf_audio_playback_demo_thread create (); E‘ Menitor Memery x 3 synergy
44 BBB1e750 sf_adc_demo_thread_create (); e
45 @001e754 sf_i2c_pcall thread_create (); Enter address or expression to monitor: & 9
5 88e1e758 sf_i2c_pcal2_thread create (); Ly lib
47 @BRle7Sc r_wdt_demo_thread_create (); | &inputimageBuffer "| D (= script 2
8081768 sf_thread_monitor_demo_thread_create (); (= synergy_cfg
43 gggie;:: siﬁilinEﬁcommiigemoitnreagicreaia (4 H % {é‘ﬁ > configurationxm
o oo ¥ _touch_panel_demo_thread create ()3 @ Cancel v B Developerbiample Da o
< >

B Console ] Tasks [[] Properties % Renesas Co... MemoryUs.. (7-Performanc... (M Profile &% Real-time C.. ©p Trace (') VisualExpre.. @ SmartBrow.. |®] Problems ({3 Executables Memory 52 = 8

P ol Bl %~
Monitors

| funning |
Follow a similar sequence for setting up outputImageBuffer address.

Step 4: Import the JPEG image form the file explorer to the inputImageBuffer addresss.
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== | 8- &> ® i 0w i HiF i Qi@ S IS
55 | Bg crces [ Git %5 Debug 3¢ Synergy Configuration
€ Expressi... 52 = O 4§ Debug 2 - & v = = B8
B % ®| | Cicd + [ DeveloperExample Debug [Renesas GDB Hardware Debugging]
Expression Type Value ~ [ DeveloperExample.elf [1]
@ Thread #1 1 (single core) (Running)
1= Img_size img_size t & . 3 Ci/Renesas/e?_studio/DebugComp/arm-none-eabi-gdb (7.8.2)
# &img size img size t* 0x200059€8 <img_size>

5. GDB senver
&= Add new expressia

[g] main.c &3 = 0 [ Project Explorer i3 = 0
7 void tx_application_define user(void * first_unused_memory) A = B -
WEAK_REF_ATTRIBUTE; = —
- = w 7 » Developerbxample [tesynergydeveloper devel ~
- >
40 void tx_application_define(void * first_unused_memory) 3 Binaries
41 ee0le740 1 [t Includes
42 8881748 dev_example_thread_create (); | [g# Import Memory 2 O % g > sic
43 9001le74c sf_audio_playback_demo_thread | 78 synergy
44 6801750 sf_adc_demo_thread_create (); Deb
45 9001754 sf_i2c pcall thread create ()] Format | RAWBinary (= Hebug
45 8881758 sf_i2c_pcal2_thread_create () Ly lib
47 @001e75c r_wdt_demo_thread_create (); Restore to address: | pxa0177000 3 (= script
13 @BO1eT6@ sf_thread_meniter_demo_thread | (= synergy_cfg
49 pRO1e764 sf_el_nx_comms_demo_thread_crd Filenome: |hishck_pandey\PEG F\‘V\img\sp\ash;(reeng*&DxZ?Z.de‘I Bmwse‘..l 5 - configurationml
56 @891e768 sf_touch_panel_demo_thread_cr o
N - - - - B [IScroll to restore address v | Developertxample Debug.jlink M
q < >
B Console ] Tasks [] Properties % Renesas Co... Mel (& . @ SmartBrow... |*] Problems {3 Executables Memory 52 = O
; @ anca | | @ 2 - )
] |4 mEl %~ ~
Menitors (™ . o
o7 3% 93¢ | &inputimageBuffer : 0x30177000 <Hex Integer> % e New Renderings...
% &inputimageBuffer address 0 -3 47 P c.r ~

& BoutputlmageBuffer
2000000090177000 67B3757D 53DD5C75 FFEFFAF6

2808000898177016 D7FFD7D7 FEED37FE S5F3F75F9 B44FFCFD
@00000ER90177020 DEED7FFF F775DEFF 7FEB567DF BDFDFFEF
©00000DDR90177030  747IFEFF D7F5FF3F 47DFAF7F BDFDSFFF
2000000090177048 7CDD790D FDFCD9FD 53FDEEFF DFFFDSFE
2000000090177056 3F3FBESF FD75937F 77045601 FFFF5580

177068  EFSF7FF DFFFFD’ SEVBAD7F EFFBDBSS
2000000090177070  7AFFFGED CDF7D74E FFF7F7Fa BFE77DE7
200000RR90177080  753BB5DD FOF55FE7 F17DFGDB DDBDDBFS
2000000090177090 EDFASF5F 1FDFFSED 6C7FFFD3 EDDGDBFF
28080008981770A8 7CDFF6F7 BD7FFADE SD5FEFaF D576F37A
@o000RRRI81778BR  7DDFSFBA D7F7D764 DDDEF7F7 FBES77479
©0000000R901770C0  FFFD78BD 55F5D4F6 57FBFFDD 3BDFFFCC
00000000901776D8 CADDF37D CEDF7F6F F75FD49D FD77CFEF
20000000901 770E6 JEFD777S 85055530 T7FCTADD FBFD7CFF
02020008901 776F0 7FDD76FS D7FC1D57 B4579FFF CDE956FD
ARBAARBAGR1TIIAR __ TRNISTEE 3IFEFEEFT NE7E7SRE INCEINGE

CLICK ON IMPORT

NOTE: Image size should not be greater than the allocated input buffer size (750 KB), otherwise the driver will return
an error. You can increase the size of input buffer from the source code of HAL JPEG (file name r_jpeg_commands.c)
by updating the INPUT_BUFF_SIZE value.

Step 4: In terminal execute the following command to set the input image and decoding parameter.

1 COM3:115200baud - Tera Term VT - O X
File Edit Setup Centrol Window Help
r_jpeg>inputBufferSet
SSP_SUCCES
r_jpeg>imageSizeGet
Horizontal = 480
Vertical = 272
SSP_SUCCESS
r_jpeg>pixelFormatGet
JPEG_DECODE_COLOR_SPACE_YCBCR420
SSP_SUCCESS
r_jpeg>imageSubsampleSet

Set image Subsample for horizontal and vertical

---HINT This allows an application to reduce the size of the decoded image
@.JPEG_DECODE_OUTPUT NO_SUBSAMPLE

1.JPEG_DECODE_OUTPUT_SUBSAMPLE_HALF

2.JPEG_DECODE_OUTPUT SUBSAMPLE_ONE_QUARTER

3.JPEG_DECODE OUTPUT_SUBSAMPLE ONE_EIGHTH

For horizontal -
For vertical -
SSP_SUCCESS
r_jpeg>horizontalStrideSet 480
SSP_SUCCESS

r_jpeg>

0
0
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e inputBufferSet command will set the address of inputImageBuffer to jpeg codec for decode
operation.

e iImageSizeGet and pixelFormatGet will print the image size(in pixel) and image pixel format on the
console screen.

e Set the image sub-sample for horizontal and vertical by entering command imageSubsampleSet
command.

e horizontalStrideSet setsthe horizontal stride value by entering horizontalStrideSet along
with value

NOTE: Horizontal stride value should not be less than the horizontal pixel value.

Step 5: Set the output buffer by entering outputBufferSet command in console. Set up output buffer image to
trigger the JPEG decode operation. You can check your current decode operation status via statusGet command.

“ COM3:115200baud - Tera Term VT — O e
File Edit Setup Control Window Help

r_jpeg>outputBuffersSet

SSP_SUCCESS

r_jpeg>statusGet
JPEG_DECODE_STATUS_DONE
JPEG_DECODE_STATUS_OUTPUT_PAUSE
JPEG_DECODE_STATUS IMAGE_SIZE READY

SSP_SUCCESS

r_jpeg>linesDecodedGet

decoded line - > 272

linesDecodedGet command will return the number of line decoded by JPEG codec.

Step 6: If statusGet returns JPEG_DECODE_STATUS_DONE it means that your current JPEG operation is completed
with success. In order to see the output image, go to the e? studio debug window under memory tab select
outputImageBuffer and add raw image rendering and set the horizontal and vertical pixel width as well as RBG
format.
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3 Console & Tasks [] Properties 3 Renesas Co... Memory Us.. (*- Performanc... (M Profile K% Real-timeC... @ Trace () Visual Expre.. @ SmartBrow.. & Problems 3 Executables  fJ Memory 32 | = 5

oo e G a‘ f 5'%|“u‘

& 9B N

Monitors o K % |&outputimageBuffer <Hex Integer> 57 New Renderings...

@ &inputlmageBuffer Memory Menitor: &cutputimageBuffer : 0x00232800

@R Soutputimagelufer Select rendering(s) to creste:

Waveform Add Rendering(s)
Hex Integer

Floating Point
Fixed Point
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Floating Point
Traditional

Raw Hex

ASCI

Signed Integer
Unsigned Integer

Select Encoding as RGB 565 with the Start Position at Top.

5 @001e754 st_iZc_pcall thread_create (); el
6 BBP1e758 sf_i2c_pcal?_thread_create (); Raw Image Format % @ﬂ "h_
BeBle?Sc r_wdt_demo_thread_create (); = script
43 900le760 sf_thread_monitor_demo_thread_create (); Dimensicns = synergy_cfg
49 BPB1e764 sf_el_nx_comms_demo_thread_create (); ) & - configurationaml
56 BBB1e768 sf_touch_panel_demo_thread_create (); Width: | 480 | 5 J
-, - = - - - v |Z| DeveloperExample Debug,jlink A4
Height: [ 272 | Q o
B Console | Tasks [T] Properties % Renesas Co... Memory Us... (- Performanc... | Encoding Bl Expre.. @ SmartBrow.. |®] Problems 3 Executables | [] Memory 32 = O
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@ BwutputimageBuffer
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Start Position
®Top
() Bottom

@

[ Runing |
Final decode output image:
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Monitors de 3 %% [BoutputimageBuffer <Hex Integer> BloutputlmageBuffer : 1530232800 <Raw Image> % . =5 Mew Renderings...
@ 8inputimageBuffer
% &outputimageBuffer
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Step 6: Enter close command to close JPEG HAL driver.
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“ COM3:115200baud - Tera Term VT — [m} e
File Edit Setup Control Window Help

r_jpeg>close

NOTE: Try this Developer Example with different image sub-sample values for horizontal and vertical as described in
Step 4 and see the effect on output image.

31. Developer Example: JPEG Decode Framework

31.1 Introduction

The Developer Example for JPEG Decode Framework will demonstrate the decode operation on JPEG image which
include selecting image from SD card and displaying the decoded image on LCD screen.

31.2 Runthe JPEG Decode Framework application

Follow the steps described in Build and Run a Developer Example application to obtain the Help menu with the list of
applications in the terminal window.

NOTE: Change the pin configuration described in JPEG Decoder Pin Configuration.

Step 1: Type sf_jpeg_decoder in the terminal and press Enter to access the JJEG HAL submenu. For Help, type
“?” and press Enter.

* COM3:115200baud - Tera Term VT - O e
File Edit Setup Control Window Help

synergy>st jpeg decoder
st_jpeg_decoder>?
st _jpeg decoder Help Menu
~ 1 Back to root menu
~ i Up one menu level
open : Open command will open the JPEG Decoder & Display driver
close : Close command will close JPEG and Display driver
setImageParameters : setImageParameters will set input image buffer,image subsample and
Horizontal stride value
getImageInfo : Prints the pixel and image format information of the input image
decode : decode command set the output image buffer address and starts the
Decode operation

sf_jpeg_ﬂecoder)l

Step 2: Type open command to open the JPEG & GLCD Framework and Driver respectively.

R11ANO024EU0140 Rev.1.40 Page 102 of 108
Sep 1, 2016 RENESAS




Renesas Synergy™ Software Package (SSP) v1.1.0 Developer Examples

“ COM3:115200baud - Tera Term VT — O e
File Edit Setup Control Window Help

st _jpeg_decoder>open

JPEG FW Open With

GLCD Driver Open With - S
Display start

st jpeg decoder>
sf_jpeg_ﬂecoder)l

Execution of open command will turn the LCD panel ON.

Step 3: Type setlmageParameter command to set the input image and image parameters. Entering
setlmageParameter command will show you the available images in the SD card on the console screen. Select
any image and press the ENTER key. The JPEG codec processes the JPEG header and prints the image information,
for example, the image size and pixel format in the console. It prompts you to set up the image sub-sample value for the
horizontal and vertical. Select the appropriate value to reduce the size of the image or set to “0”(zero) for horizontal
and vertical to keep the original size.
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L COM3:115200baud - Tera Term VT - O *
File Edit Setup Control Window Help

st _jpeg decoder>setImageParameters

System Volume Information
Renesas_Synergy.jpg
Renesas_Screen.jpg
Partly_Cloudy.jpg
Beach.jpg

Rainy.jpg

Grass.jpg
Space-Wallpaper.jpg
Sunflower.jpg

Select Image -Renesas_Synergy.jpg
JPEG CODEC STATUS ->»
JPEG_DECODE_STATUS_IDLE

#Successftully set the input image#f
Size of the image in pixel :-
Horizontal 1 480
Vertical 1 272
Pixel Format : JPEG_DECODE_COLOR SPACE_YCBCR420
JPEG CODEC STATUS ->»
JPEG_DECODE_STATUS_IMAGE SIZE READY

Set image Subsample for horizontal and vertical

---HINT This allows an application to reduce the size of the decoded image
©.JPEG_DECODE_OUTPUT_NO_SUBSAMPLE

1.JPEG_DECODE_OUTPUT_SUBSAMPLE_HALF
2.JPEG_DECODE_OUTPUT_SUBSAMPLE_ONE_QUARTER

3.JPEG_DECODE_OUTPUT SUBSAMPLE_ONE_EIGHTH

for horizontal - @
for vertical -0

Setting up horizontal stride
Horizontal stride set successfully

ALL Parameters Set Successfully
sf_jpeg_decoder>]]

NOTE: In case If you fail to set the image or its parameters, you need to do close>open and then try with
setlmageParameter command.

Step 4: If the image and parameters are set with success, type the decode command to start the JPEG decode
operation.
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B COM3:115200baud - Tera Term VT — O be
File Edit Setup Control Window Help

st_jpeg _decoder>decode

JPEG CODEC STATUS ->»
JPEG_DECODE_STATUS_DONE
JPEG_DECODE_STATUS_INPUT_PAUSE
JPEG_DECODE_STATUS_OUTPUT_PAUSE
JPEG_DECODE_STATUS_IMAGE SIZE READY

st _jpeg decoder )I

The decode command converts the jpeg file to a raw RBG image file that is displayed via the LCD screen.

(decode command will automatically display the decoded image on LCD screen)

Step 5: Enter close command to close JPEG and LCD.
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“ COM3:115200baud - Tera Term VT — O e
File Edit Setup Control Window Help

st _jpeg_decoder>close

Display driver Stop With

JPEG Close With h
Display driver close With - SS
sf_jpeg_ﬂecoder)l
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32. Additional Technical Notices

Subscribe to the Synergy Technical Bulletin Board to receive the latest technical news and notifications about new
features, known issues, workarounds, and release announcements. To subscribe, visit
http://renesasrulz.com/synergy/synergy_tech notes/f/214.aspx. Sign in to Renesas Rulz, and click ‘Email Subscribe to

this forum’.

Additional technical information, including informative papers and articles on SSP and Renesas Synergy can be found
at the Synergy Knowledge Base, https://knowledgebase.renesas.com/Renesas_Synergy Platform.
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Website and Support
Support: https://synergygallery.renesas.com/support

Technical Contact Details:

e America: https://renesas.zendesk.com/anonymous_requests/new
e Europe: http://www.renesas.eu/support/index.jsp
e Japan: http://japan.renesas.com/contact/index.jsp

All trademarks and registered trademarks are the property of their respective owners.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas.
For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as
well as any technical updates that have been issued for the products.

1. Handling of Unused Pins

Handle unused pins in accordance with the directions given under Handling of Unused Pins in the
manual.
— The input pins of CMOS products are generally in the high-impedance state. In operation with
an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
LSI, an associated shoot-through current flows internally, and malfunctions occur due to the
false recognition of the pin state as an input signal become possible. Unused pins should be
handled as described under Handling of Unused Pins in the manual.
2. Processing at Power-on
The state of the product is undefined at the moment when power is supplied.
— The states of internal circuits in the LSI are indeterminate and the states of register settings and
pins are undefined at the moment when power is supplied.
In a finished product where the reset signal is applied to the external reset pin, the states of
pins are not guaranteed from the moment when power is supplied until the reset process is
completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset
function are not guaranteed from the moment when power is supplied until the power reaches
the level at which resetting has been specified.
3. Prohibition of Access to Reserved Addresses
Access to reserved addresses is prohibited.

— The reserved addresses are provided for the possible future expansion of functions. Do not

access these addresses; the correct operation of LSI is not guaranteed if they are accessed.
4. Clock Signals

After applying a reset, only release the reset line after the operating clock signal has become

stable. When switching the clock signal during program execution, wait until the target clock signal

has stabilized.

— When the clock signal is generated with an external resonator (or from an external oscillator)
during a reset, ensure that the reset line is only released after full stabilization of the clock
signal. Moreover, when switching to a clock signal produced with an external resonator (or by
an external oscillator) while program execution is in progress, wait until the target clock signal is
stable.

5. Differences between Products

Before changing from one product to another, i.e. to a product with a different part number, confirm

that the change will not lead to problems.

— The characteristics of Microprocessing unit or Microcontroller unit products in the same group
but having a different part number may differ in terms of the internal memory capacity, layout
pattern, and other factors, which can affect the ranges of electrical characteristics, such as
characteristic values, operating margins, immunity to noise, and amount of radiated noise.
When changing to a product with a different part number, implement a system-evaluation test
for the given product.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for
the incorporation of these circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the use
of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free. Renesas Electronics
assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or
technical information described in this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics assumes no responsibility for any losses incurred by you or
third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality". The recommended applications for each Renesas Electronics product depends on
the product's quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic
equipment; and industrial robots etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-crime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical
implantations etc.), or may cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality grade of each Renesas Electronics product before using it
in a particular application. You may not use any Renesas Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable for any damages or losses
incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage
range, movement power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or damages arising out of the
use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and
malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them against the
possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to
redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult,
please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please use Renesas Electronics
products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics assumes
no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or
regulations. You should not use Renesas Electronics products or technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the
development of weapons of mass destruction. When exporting the Renesas Electronics products or technology described in this document, you should comply with the applicable export control laws and
regulations and follow the procedures required by such laws and regulations.

10.

5]

It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise places the product with a third party, to notify such third party in advance of the
contents and conditions set forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of unauthorized use of Renesas Electronics
products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.
(Note 1) "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.
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